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What is RawDigger 
RawDigger by LibRaw, LLC, is a tool to visualize and examine pure raw data as the camera has recorded it. 

In essence, it is a microscope of sorts that lets you drill down into raw data. 

RawDigger doesn’t alter the raw data in any way. RawDigger is not a raw convertor. Instead, it allows you to 

see the data that will be used by raw convertors. 

RawDigger supports nearly all cameras that have raw capability. Support for new cameras is usually 

implemented within few weeks after raw samples become available. 

Some unique RawDigger features: 

• RawDigger displays the real histogram of the raw data, which greatly differs from the in-camera 
histogram and histograms presented by most of the raw convertors. 

• Overexposure (OE) indicator will show you exactly what areas of the shot are blown out and in 
which color channel(s) it happened (best if used in channel view). 

• RawDigger allows determining how exposure meter is calibrated and what raw level corresponds to 
the midpoint of in-camera histogram. That is, RawDigger lets you establish the headroom in 
highlights and obtain optimal exposures. 

• For ETTR practitioners, RawDigger makes it very simple to compare raw histogram to in-camera 
histogram and account for the difference, making the exposures as much “to the right” as possible. 

• RawDigger helps determining the raw level at which the overexposure “blinkies” start on the 
camera LCD and to know how much headroom is still available after the blinkies start showing. 

• If the shadows look blotchy, colorless, or details in shadows are poorly resolved you will be able to 
determine how much they are underexposed and set Underexposure (UE) indicator in RawDigger 
accordingly. 

• RawDigger is a useful tool for examining how the relative per-channel underexposure depends on 
the color of light. 

• RawDigger is more precise than any exposure meter for the purpose of evaluation of the uniformity 
of fill light and reproduction light setups (in terms of the evenness of both color balance and 
luminosity across the background). 

• For studio photography RawDigger helps establishing the proper light filtration to achieve the 
cleanest possible shadows on the shots. 

• Landscape photographers may want to use RawDigger to determine the effect of the filters on the 
lens, to check neutrality of polarizing and neutral density filters and, possibly, to select color 
correction and color compensation filters to use in different light. 

• RawDigger can be used to check the amount of vignetting caused by the lens and the sensor. 

• RawDigger helps determine the idiosyncrasies of both camera and raw convertor by providing a 
true view into the raw data and comparing it to the results obtained through raw conversion. 

Some of the more advanced features, depending on the RawDigger edition, include: 

o RAW data export as TIFF. 
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o Plot and save per channel raw data histograms for both the entire file and for an arbitrary 
rectangular area of the file (selection). The histograms can be saved as graphics or as a table 
for further external processing. 

o Calculate the statistics per channel (minimum, maximum, average, root-mean-square 
deviation) for the entire file and for an arbitrary rectangular selection. 

o Calculate the statistics per channel and save the results in a processing-friendly form  - CSV, 
CGATS (for an arbitrary number of rectangular areas of the file). 

o Save the compression curves of raw files in a tabulated form (for cameras and raw data 
formats where such curves are used). 

RawDigger is available in several editions: 

• Exposure Edition is for everyday use and is intended to help those who are serious about extracting 
the maximum quality from the camera to get precise exposures. 

Exposure Edition displays RAW data in all modes (RGB, RAW Composite, and RAW per channel), 

indicates over- and underexposed areas, displays RAW histogram, image statistics, as well as 

statistics and histogram for selected area. 

• Research Edition is meant for camera/sensor evaluation and statistical analysis of raw data. It is 
suitable for a wide range of tasks, starting from personal use and preparing reviews and all the way 
to programming RAW data processing. 

Research Edition adds TIFF export, multiple selected areas via samples, tables of sampled data; 

statistics and histograms over multiple samples, exporting sampled data as CSV and CGATS. 

• Profile Edition is for those who need to create sensor calibration data, linearization data, or device 
data for color profiling. 

Profile Edition adds selection grids for faster processing of step wedges and color targets, as well as for 

calculating non-uniformity maps. Profile Edition allows applying white balance, normalization, equalization 

(Flat Field), and filtering of outlying values before data export. 
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RawDigger Editions feature table 

 
RawDigger 
Exposure Edition 

RawDigger 
Research 

Edition 

RawDigger 
Profile Edition 

User Groups and suggested 
usage 
 

General photography: 
exposure evaluation, 
exposure meter 
calibration, verification of 
the light evenness 
(brightness and white 
balance consistency) 

Camera and 
RAW data 
analysis 
(evaluating 
cameras, 
preparing 
camera reviews, 
programming 
RAW data 
processing) 
 

Creating 
calibration, 
linearization 
tables; preparing 
data for color 
profiling  

Reads all supported RAW 
formats  

+ 
+ + 

Display of RAW data in all 
modes (RGB, RAW 
Composite, and RAW per 
channel) 

+ 
+ + 

Display of Over- and 
UnderExposed areas 

+ 
+ + 

Display of the histogram and 
statistics for the entire file   

+ 
+ + 

Statistics and histogram for 
one selected area 

+ 
+ + 

TIFF export - 
+ + 

Multiple selected areas 
(samples and table of 
sampled data): statistics, 
histogram, and export to CSV 
and CGATS formats 

 
- 

 

+ 

 

+ 

Filtering of the data to be 
exported: white balance, 
normalization, equalization 
(Flat Field), filtering of 
outlying values. 

 

- 

 

- 

 

+ 

Selection grids (for fast 
processing of color targets 
and step wedges)  

- 
- + 
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System Requirements 
Windows: Currently, the program requires a computer with Windows (XP SP2+, Vista, 7), 32 or 64-bit, 1GB 

memory, CPU supporting SSE2 or higher (Intel Pentium 4 or newer). Screen resolution should be 1024x768 

or more.  

Mac OS X: Intel Mac running Mac OS X 10.5 or newer. The program may work under 10.4, but this has not 

been tested. Both 32- and 64-bit systems are supported. 

Linux: Currently, users report that one can use Wine to run RawDigger under OS X and Linux (configurations 

reported as tested are OS X 10.6.8 and Wine-1.2.3; Wine (1.3.37-0ubuntu1~ppa1~lucid1) and Debian 

testing. 
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Program Installation 

Windows 
The program is installed by running the executable file of the distribution package (RawDigger-1.0.0.xxx--

Setup.exe) 

If you downloaded RawDigger from our site on the first program launch, current versions of Windows will 

display the following security warning: 

 

After the “Run” button is pressed, the UAC (Windows User Access Control) system will display a warning 

once again: 

 

Both dialogs allow you to verify that the setup program is signed with unique LibRaw LLC electronic 

signature. 

To proceed with the installation, you must agree to the dialog above, and the usual Setup Wizard will be 

launched: 
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At the next screens of Setup Wizard: 

1. The User License is displayed 

2. An installation folder is suggested; a different folder may be selected by the user 

3. Creating a Group in the Programs menu is suggested 

4. A list of possible additional actions is shown: add icon to the desktop, add icon to the Quick Launch 

menu 

Afterwards, the installation takes place. Upon completion, the following screen appears: 
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In case of any errors during installation, please post to the technical support forum at 

www.rawdigger.com/forum  (English or Russian languages are OK). 

Mac OS X 
Double click on RawDigger-1.x.x.dmg to mount the RawDigger disk image you've downloaded. The content 

of the disk image will appear like this: 

 

Drag RawDigger icon onto the Applications icon. The program will be copied to Applications folder and 

ready to run. 

Other items contained in the disk image are: 

• RawDigger Manual (RawDigger-manual.pdf) 

• Brief description (README.txt) and Changelog (Changelog.txt) 

• End-User License Agreement (EULA.txt), Copyright Information (Copyrights.txt), Licenses and 

Copyrights for libraries and components used in RawDigger (folder Licenses. 

  

http://www.rawdigger.com/forum
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Program Activation 
During the first launch RawDigger will display a splash screen suggesting the activation of the trial version 

 

Next, an activation dialog will be displayed: 

 

After the Activate Trial button is clicked, the program will be activated in trial mode for 30 days. During this 

period, all RawDigger features will be available. 

To use RawDigger after the trial period, the user will need to obtain a full license for the RawDigger edition 

of his or her choice.  

To obtain the license, please click the “Buy License” button or open www.rawdigger.com/purchase in your 

browser. As a result of the transaction, you will be provided with the license key (online and as a separate 

email). This license key should be entered into the License Key field of the activation dialog, which is also 

available through Menu-Help-Purchase/Activate): 

http://www.rawdigger.com/purchase
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After the license key is entered, please click Activate license button. The license will be activated and you 

will be able to continue using the program. 

The Help-Purchase/Activate menu item will now be renamed to Help-Registration data, and the respective 

dialog will show your registration data: 

 

To complete the activation (of both the trial and the fully licensed version) the program needs a one-time 

access to the Internet. If you cannot grant the appropriate Internet access permissions, you can activate the 

program manually.  

Manual Activation 
If the program fails to connect with the activation server, you will see a pop up alert, with a «Manual 

Activation» button on the bottom right of the notification window. 
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After clicking the «Manual Activation» button, a «Manual Trial Activation» window will pop up: 

 

Depending on your Internet access, you can use one of the 3 ways to obtain the activation code: 

By using browser (if your browser has an internet connection)  – use this if your browser can connect to 

the Internet.  

Simply click this url: http://activate.rawdigger.com/activate.cgi and you will see a browser window pop up 

with your unique activation key: 

http://activate.rawdigger.com/activate.cgi
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By using E-mail client with an automatically prepared message  – click the mailto:activate@rawdigger.com 

link and your mail client will create a new pre-populated email to activate@rawdigger.com. You will only 

need to click send. 

By using an E-mail client and manually writing the message – you can send an email to 
activate@rawdigger.com using the text in the window below (I'm unable to activate…»  
If you choose to obtain the activation key via email, you will receive a reply email with the text identical to 
that which you would see in the web browser (the activation key, however, will be different.) 
 

You can then use the Activation Key (from the browser or email) and enter it into the Activation Key field (it 

is best to use Copy-Paste, as every character of the key is important) and press «Activate.» 

After clicking the «Close window» button, the window will close and the RawDigger activation window will 

display the registration status (as well as the edition you are using.) 

 

 

  

mailto:activate@rawdigger.com
mailto:activate@rawdiffer.com
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Program Usage 

Starting RawDigger 

Windows 

To start RawDigger, double-click its icon on the Desktop, or use the Windows Start menu 

If the program is started from the command line, the first argument is interpreted as a name of the raw file 

to open. Consequently, if an icon of a raw file is dragged onto the RawDigger program icon the program will 

start and open this raw file.  

If “single instance” mode is in effect (see Preferences below) and RawDigger is already running, starting a 

new RawDigger process with a file name to open as a command line parameter will cause the file to be 

opened by the already running instance.  

To open a new RawDigger instance start RawDigger with –newinstance parameter, such as 

RawDigger –newinstance filename 

This will cause the new window to open even while in “single instance” mode. 

Mac OS X 

To start RawDigger, double-click its icon or drag a raw file icon onto the RawDigger icon. 
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Main Program Window 
The main window of the program shows the name of the current (opened via menu command File->Open) 

raw file, its metadata and some statistical data. The file view mode is also selected in the main window. 

 

The main program window displaying an opened raw file. Information blocks and controls are marked 

with digits in red. 

1. File metadata 

This window displays: 

a. The file name (as a window caption) 

b. Camera make and model 

c. Shutter speed, aperture, ISO sensitivity value 

d. Type of metering and exposure correction (if it was applied at the time of shooting) 

e. Lens type 



RawDigger User Guide 

Page 16 of 90 © Copyright 2012-2026, LibRaw LLC, www.libraw.com 

f. Focal length at which the shot was taken 

Pressing “EXIF” button here, you can open a window displaying EXIF metadata for the file (see below for 

sample EXIF output window). 

2. Raw data statistics per channel 

Block header: image size in pixels. Block body: minimum, maximum, average (Avg) and root-mean-

square deviation of pixel values in each color channel (σ). 

3. Statistics per channel for the last selected area  

Block header: coordinates of top left corner of selected area (X-Y-W-H). Block body: minimum, 

maximum, average and root-mean-square deviation of pixel values in each channel within the selected 

area. 

4. Mouse pointer coordinates and the corresponding raw values  

Block header: mouse pointer coordinates (X-Y). Block body: value in pixel or in 4 pixels under the 

pointer (which mode it is, 1 or 4 pixels, is set in the Preferences window; see Preferences section 

below). 

5. Image view mode: 

• RGB render: shows the RGB representation with the selected (see description of 

Preferences below) white balance. This mode is not available for cameras where the aspect 

ratio of a single pixel differs from 1 (for example, some Fuji cameras). 

• Raw Composite: for an RGB(G)-Raw it is an RGB-image where the green channel is 

computed by averaging two green channels available in the raw file. For all raw file where 

the CFA is not RGB(G) (but rather CFA is of a different type, like CMYG, RGBE, etc.) a 

grayscale image is displayed (i.e. Show RGBG in grayscale setting /see below/ is forced on 

for such files). 

• Raw channel: the selected channel is shown in the black-and-white mode. 

• OvExp: switches overexposure indication On; the overexposed areas are highlighted in red. 

• UnExp: switches underexposure indication On; the underexposed areas are highlighted in 

blue. 

6. Statistics for over- and underexposed areas. 

For each color channel the number and the percent (relative to the total number of pixels of the given 

color) of saturated and underexposed pixels is indicated. 

7. Black level subtraction status display: 

Current Black Level subtraction mode is indicated right on the button; Auto for the value reported by 

the camera, same as the level displayed in the block #1; Off when no black level subtraction is 

performed; Manual and Value if the same value of the black level is subtracted from all the channels; or 

1-4 values in brackets when black level is established individually for each of the channels. When this 

button is pressed the “Settings” dialog window is opened (more on “Settings” dialog see below), with 

the focus on the “Data Processing” pane. 

8. Decompression using compression curve data from raw file: 

The indication on the button can be Normal if the standard tone curve contained in the raw file is used; 

Linear, if a 45-degree straight line is used; or N/A if the particular file tone curve in raw is not applicable.  

When this button is pressed the “Settings” dialog window is opened (more on “Settings” dialog see 

below), with the focus on the “Data Processing” pane. 
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9. Image zoom 

The + and – buttons change the scale, and the Fit To Window pull-down menu can be used to select the 

scale from list. 

10. Frame selection (for multiframe Raw) 

The dropdown list is used to select the frame to be shown. This interface element is not available for 

files containing only one frame (most raw formats). 

11. Section containing  controls of the brightness of RGB render  

This section allows to control the brightness of RGB render in a non-linear fashion, through setting the 

value for gamma increase, 0 .. 3 above the regular value of 2.2, for the total value of gamma to be 2.2 .. 

5.0. This method makes room for increased brightness in shadows and midtones by compressing 

highlights, not by clipping them. 

12. Right-clicking selections and samples opens the context menu; from here you can delete the selection 

or sample; show/hide the histogram; convert (change) selection to sample.  

 

Statistics panes for the whole image as well as for a selection may display additional  indicators (see picture 

above): 

• [M] in the "Image" pane indicates that the display of "black frame" is ON and the statistics includes the 

data from the masked pixels (the sensor area that does not contain image) 

• [F] in the "Selection/Sample" pane indicates that filtering of outlying values is ON (please refer to 

Preferences - Data Processing - Discard abnormal pixel values section) 

Working with the Main Window 

• Moving the pointer allows the user to see the pixel values (raw data) under it. Depending on the view 

mode (see Preferences section below), the program shows either the data value for a specific pixel (the 

remaining three components are zero) or the pixel values of all 4 color channels for the 2x2-pixel square 

under the mouse pointer. 
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• Pressing the Alt + left mouse button allows the user to set a sample of a fixed size. The size of the 

sample is specified in the program preferences (see Preferences section below). The samples set earlier 

in the image have a gray semitransparent background and green border. Operations with samples are 

described below, in the Samples Window section. 

• Pressing Shift and the left mouse button allows the user to make a rectangular selection of an arbitrary 

size. One angle of the sample is fixed at the moment when the mouse button is pressed; the opposite 

angle, at the moment when Shift is released. Only one selection can exist at a time, but can be 

converted into a sample. Operations with selections are described below, in the Selection Menu section 

of Program Menu. 

• Left-clicking allows one to scroll the image in the program window 

• Left-clicking a selection or sample allows to re-position the selection or the sample 

• Right-clicking a selection or sample displays a context menu: 

o Delete – to delete the selection or the sample 

o Show/Hide Histogram – to show or hide the histogram for this selection or sample 

o Convert Selection To Sample (available only for the active selection) – converts the selection to 

the sample, that is now the data for the selection is available in the «Samples Window»  (more 

on the «Samples Window» please see below). 

• Drag and Drop – raw file can be dragged and dropped to the program window or onto Histogram 

window; this has the same effect as selecting the file through File->Open. 
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Display of the areas of under- and overexposure 

If the checkboxes OvExp (overexposure indication) and/or UnExp (underexposure indication) are On in the 

Display section the areas with blown-out highlights and/or with plugged shadows will be highlighted with 

red/blue colors, respectively. 

 

To adjust the levels at which the over- and/or underexposure is diagnosed please use Preferences, 

Over/Under Exposure section (see below “Preferences” section).  

EXIF Window 

The EXIF data window will be displayed, if: 

• The EXIF button in the metadata info block is pressed 

• Menu – Windows – EXIF is used 

The EXIF window displays the metadata contained in the file as extracted by Exiftool: 



RawDigger User Guide 

Page 20 of 90 © Copyright 2012-2026, LibRaw LLC, www.libraw.com 
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“Filter:” -- this field allows one to enter filtering conditions, based on substring(s): 

 

The “Filter:” field allows one to use regular expressions (in PCRE format); for example, Width|Height will 

result in the display of only those strings that contain substrings Width or Height. The search is case-

insensitive. 

The buttons to copy the EXIF data to Clipboard and to close the EXIF window are located at the bottom part 

of the EXIF window: 

• Copy to Clipboard (text) button allows one to copy the EXIF table into the Clipboard as text 

• Copy to Clipboard (HTML) button allows one to copy the EXIF table into the Clipboard as HTML 

(preserving the formatting tags) 

The “Copy full table” checkbox is useful if the filtering is on, but one still wants to place the un-filtered (full) 

EXIF data into the Clipboard, ignoring the effect of filtration. 



RawDigger User Guide 

Page 22 of 90 © Copyright 2012-2026, LibRaw LLC, www.libraw.com 

Program Menu 

File Menu 

• Open: opens a raw file. If the operation has failed for some reason (format not supported, file 

corrupted), the program will keep the previously opened file active. 

If the current file contains samples whose data has not been yet saved, the program will ask if you want 

to save them prior to opening a new file. The coordinates of the existing samples and selection will be 

preserved after the new file is opened if they fall completely within the size of the new file. Other 

samples and selections will be lost. For the remaining ones, the statistical data will be recalculated using 

the values from the new file. 

• Next file: opens the next raw file in the current directory. The settings for the sorting order can be 

found at Preferences - Misc. Options – File order. If the end of the list is reached and the user attempts 

to open a “next” file, the program responds with a beep, warning that there are no further files.  

• Prev File: opens the previous raw file in the current directory. 

• Close file:  closes the current file, frees up memory 

o closes all additional windows (samples, histograms) 

o changes the current folder to %HOME%/Pictures or %HOME% 

Useful when working with removable media (flash cards, and others), allows to un-mount and eject the 

device without closing RawDigger 

• Export Tiff: exports the data of the currently opened RAW-file as TIFF (see Data Export section below). 

• Dump RAW curve: this menu item is active only for raw files that use a tone (compression) curve during 

unpacking. Using this menu item, the user can save the tone curve in the CSV format for subsequent 

examination. 

• Screenshot: saves the image of the main program window in the PNG or JPG format. PNG is the default 

format; to save in JPG, one should select this extension in the File Save dialog box. 

Note: this option is disabled and not visible in the menu if Preferences – Misc. Options – Use OpenGL 

for bitmap draw option is checked. 

• Preferences: activates the dialog box, see description below in the Preferences section. 

• Exit: quits the program. If there are any unsaved samples of data, the program will ask if you want to 

save them. 

• In addition to the standard menu items listed above, the program remembers the 5 most recent files 

and displays their list in the File menu. 

View Menu 

The View menu duplicates the image zoom controls at the bottom of main program window. 

• Zoom In  

• Zoom Out 

• Normal Size sets the scale to 100% (1:1) 

• Fit To Window sets the scale so that it fits to the program window 

• Full Screen turns RawDigger to full-screen mode. 
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Window Menu 

The Window menu makes it possible to show/hide additional program windows: 

• Histogram - Entire file histograms (see “RawDigger Histograms” section below). 

• Samples Window - Samples tables (see “Samples Table” section below). 

• EXIF – Exif window. 

Selection Menu 

The Selection menu allows the user to perform the following actions over the selected area: 

• Clear Selection: removes the selected area. 

• Selection Histogram: opens the window with a histogram of the selected area (see RawDigger 

Histograms section below). 

• Convert Selection to Sample: converts the current selection to a sample and adds it to the samples list 

(see Samples Table section below). 

• Set Selection by Numbers: allows one to position the selection area precisely by entering the 

coordinates of the top left corner of the selection, its width and height 

  
When «Center selection on image» is checked «Left» and «Top» fields are grayed-out. The position of 

the top left corner is calculated automatically so that the center of the selection is in the center of the 

image. 

• Selection Grid: to be used for reading data off color targets and (non-)uniformity analysis as described 

in “Selection Grid” section below. 

 

Help Menu 

The Help menu contains five items: 

• Supported Cameras: shows the list of the cameras supported by the given version of RawDigger. 

• Check for Updates – checks if there are any updates of RawDigger for the version of RawDigger you are 

currently running. 

• Registration Data (for the full license) or Purchase/Activate (for the Trial mode) – displays 

activation and registration data dialog 

• Technical Support Forum – opens support forum page in your browser. 

• Contact Support – opens feedback form in your browser. 

• About: shows information about the program version, available updates, etc. 
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Hot keys and Shortcuts 

MS Windows 

• Ctrl-O to open a file, same as Menu->File->Open 

• Ctrl -> (Arrow Right) – to open the next file (Menu -> File -> Next file) 

• Ctrl <- (Arrow Left) – to open the previous file (Menu -> File -> Prev file) 

• Ctrl-E – to open the data export dialog (Menu -> File -> Export Tiff) 

• Ctrl-P to access the Preferences dialog, same as Menu->File->Preferences 

• Ctrl-Q to exit the program, same as Menu->File->Exit 

• Ctrl-+, Ctrl-= to zoom in, same as Menu->View->Zoom-In 

• Ctrl—to zoom out, same as Menu->View->Zoom-Out 

• Ctrl-S to display the image at 100%, same as Menu->View->Normal Size 

• Ctrl-F to scale the image so that it fits the program window, same as Menu->View->Fit to Window 

• Ctrl-H to show/hide the histogram window, same as Menu->Window->Histogram 

• Ctrl-L to show/hide «Samples Window» containing the table of measurements from samples, same as 

Menu->Window->Samples 

• Ctrl-M to convert the current (active) selection to the sample, same as Menu->Selection->Convert 

Selection to Sample 

Mac OS X 

Same hotkeys as in Windows version, but with Command instead of Control (i.e. Command-O opens file and 

so on). The only exception is Histogram open/close: Option-H is used because Command-H is reserved for 

hiding entire program window. 

RawDigger Histograms 
The Window->Histogram menu item shows the window with per channel histograms plotted using all the 

file data.  

RawDigger histograms have the following features: 

1. The Horizontal scale can be either linear (according to values in raw data from the currently opened 

file) or photographic (linear with respect to the EV scale, that is, every next step of the scale contains 

twice the signal compared to the previous one). The horizontal axis has two sets of tick labels: linear 

under the histogram and photographic above the histogram. 

2. The Vertical scale can be either linear or logarithmic.  

3. The width of the histogram columns (bins) is always equal to an integer number of pixels in order to 

reduce aliasing (moiré). Hence, if the column (bin) width is chosen automatically, the histogram 

occupies from ½ to all of the window width and cannot be zoomed by an arbitrary factor. 

4. All per channel histograms are displayed using the same scale. 

The histogram window contains histogram controls, which are shown on the figure on the next page. 
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Histogram window: the red digits mark the controls described below. 

1. Save CSV: saves the histogram in the form of a CSV file suitable for further processing (e.g., in Microsoft 

Excel). The data in the histogram bins is saved according to the current preferences (bin width, work 

mode, etc.; see below). 



RawDigger User Guide 

Page 26 of 90 © Copyright 2012-2026, LibRaw LLC, www.libraw.com 

2. Save PNG: saves the histogram in the form of a graphic file (PNG or JPEG; to save it in JPEG, one should 

select the extension .jpg or .jpeg for the file to be saved). 

3. Save Full Data: saves the unprocessed histogram data (not sorted into bins); data is saved as the signal 

level value vs. the number of pixels with this value. 

4. Histogram representation in linear mode 

In the linear mode, the horizontal scale is constant all along the horizontal axis. In this mode, the major 

portion of the plot is occupied by highlights (and, to a lesser extent, midtones) of the image, whereas 

the shadows occupy a narrow range near the left border of the histogram. 

Linear mode controls: 

• Linear X-axis: linear mode on. 

• Auto: automatic choice of minimum/maximum and histogram bin width according to 

horizontal axis. 

• Bin Size: manual setting of bin width (number of levels in one bin is set). 

• Range: setting of the visible range on the horizontal axis. 

5. Histogram representation in photographic mode 

In the photographic mode, the horizontal scale is linear with respect to the exposure stops (exposure 

value units, EV). Each stop, regardless of its position in the tonal range of the photo (shadows, 

midtones, highlights), occupies the same length along the horizontal axis of the histogram. 

In the shadows, the number of possible levels may be smaller than the one set by the histogram bin 

size. For example, the ”3rd photographic step from black level” of the image corresponds to values from 

4 to 7 inclusively, meaning that there are 4 different levels. In this case, some of the bins will have a 

height of zero and there will be ”holes” in the histogram. 

Photographic mode controls: 

• EV-scale X-Axis: photographic mode on.  

• Auto: automatic choice of bin width and visible histogram range. 

• Bin size: manual setting of bin width, as a fragment of 1EV (photographic stop). 

• Range: setting of the visible range on the horizontal axis. 

• Update Linear Scale: if on, modifications of photographic mode range will also change the 

linear range. 

6. Viewing EV grid 

The EV grid (photographic stops) is shown in the form of solid vertical lines in the histogram field.  

Controls: 

a. Show EV Grid: show/hide EV grid. 

b. Auto: automatic calculation of grid zero (gray point position) and setting grid step to 1EV.  The 

zero is located at the level that is 3 stops (8 times) lower than the maximum pixel value rounded 

up (ceiling) to the nearest power of 2. For example, if the maximum value of all pixels in the 

photo is 3000, then the nearest power of two greater than this value is 4096 and the EV0 value 

for this photo will be automatically set to level 512. 

The maximum can be determined either as the maximum pixel value in the currently opened 

frame, or as a theoretical maximum for the given camera. The setting that switches on the 

choice of the theoretical maximum for the maximum is available in Preferences – Histograms – 

Set histogram EV0 by  (please see the chapter on Preferences below). 
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c. 0 EV at: setting the level for EV0. In photographic mode of the histogram display, changes in 

EV0 also affect the data visualized; hence, the look of the histogram changes. 

d. EV tick: setting the EV grid step (1/3EV, 1/2EV, 1EV, 2EV). 

7. Vertical scale control  

Vertical scale display is controlled using the following elements: 

a. Auto – the upper limit is determined automatically so that all the counts fit into the histogram 

window while the lower limit is always set to zero 

b. Scale – controls the scaling of the vertical axis: 

i. Linear – the scale of the vertical axis is linear 

ii. Logarithm – the vertical scale is set to logarithmic; the graph is calculated for 

log(count+1) to prevent log(0) issue. 

iii. Square root – the height of the bars is proportional to the square root from the number 

of pixels that correspond to the bin. 

c. Grid – display the horizontal grid lines. 

d. Max -  set the maximum value for vertical axis, available only with Auto off. 

8. Statistical data for the histogram: 

a. Min/Max – minimum and maximum values for the pixels in the given channel (color) 

b. Pixels – for the area which is used for the histogram, number of pixels in the given channel.  

c. Values – number of different pixel values in the given channel (this number is a count of non-

empty histogram bins, where the bin width is independent of the histogram display mode and 

has the width of one data number (if the minimum is 1, and the maximum is 16383, the total 

number of bins is 16383, but some bins may be empty and not counted in Values).    
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Samples Table 
The Samples window shows the table with the samples created in the file: 

 
Samples window 

The Samples table lists (left to right): 

• Coordinates of the top left corner and the size of the sample (format X-Y-Width-Height). 

• Sample number. 

• For each color channel: the minimum (min), average (avg), maximum (max) values and root-mean-

square deviation (dev) over the sample area. 

 

The background color of the cells corresponds to the «colors» of the respective raw channels in the file. 

The font color corresponds to the font color in the informational blocks of the main window (blue for 

min values, green for max values, black is used for display of average and standard deviation.) 

One or several rows in the table can be selected (to select several rows, click them holding down the Ctrl 

key). The selected rows will have a blue background (see image above).  

If some rows are selected, the corresponding samples in the main program screen start blinking. 

The top part of the window, above the list of samples, contains the following controls: 

1. Save Samples: saves all values from the samples list (see section Saving Samples Table below). 

Append File: activated if samples have already been saved during the current program session and the 

selected format allows appending. If this box is checked, Save Samples button changes to Append File, 

no new file name dialog appears, and the data is appended to the file that was created earlier. The 

Append File option is activated only if the previous data file was saved in the CSV format (see below); 

for the CGATS format, appending samples to a file is not possible. 
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2. Histogram: opens windows with histograms for all selected table rows. The histograms are shown only 

for samples containing more than 25 pixels. 

3. Remove Sel.: removes the selected rows and corresponding samples in the main screen; closes the 

windows (if any) with histograms corresponding to the samples. 

4. Sel. to Clipboard: copies the selected rows in system clipboard. If ‘Header to Clipboard’ checkbox is 

checked, the data will be copied with the table headings. 

5. Remove All Samples: this button removes all samples from the table. 

6. Load – loads a previously saved file with coordinates of sampling (see below, «Saving Samples Table»). 

When loading, select a previously saved file and, if you want to keep the existing samples too, uncheck 

Clear existing samples 

The Samples table is enabled in Research and Profile Editions of RawDigger. 
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Saving Samples Table 

When saving the Samples table, the dialog window similar to following is displayed: 

 

Save Samples Table window. 

In addition to standard dialog elements which are used to specify the name of the file, this window contains 

additional controls for saving the samples table: 

1. The File Format block is used to choose the format of the saved file: 

• CSV: saving in Comma Separated Values format, which is convenient for subsequent data analysis in 

Microsoft Excel and similar programs. 

• CGATS: saving in Committee for Graphic Arts Technologies Standards format, which is used, among 

other things, in color profiling software. 

• Flat Field Data – this file contains the characterization of the variations in the sensor response that 

occur due to light variations at the space occupied by the target, as well as caused by different 

forms of vignetting. 
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Data will be obtained by shooting an even monochrome non-textured matte surface (thick white 

paper or plastic is OK given they are placed physically flat) placed on top of the target or instead of 

the target, in exact same light, same focusing, same aperture, and same camera position. Same 

camera ISO setting may be needed too. The shutter speed for flat field shot does not need to be the 

exact same as for the shot of the target itself. In practice, the higher the exposure for the flat field 

shot is, the better accuracy can be achieved; however flat field shot shall have no overexposed 

zones whatsoever.  

We suggest starting with overexposing the flat field shot by 1.5 EV over the meter readings in 

center-weighted or spot mode. As usual for this type of work, a steady enough tripod and remote 

camera control make things easier.  

Flat field data if present can be used to normalize the target shot data to overcome most of non-

uniformities. The data for the flat field shots is stored in RawDigger-specific format 

• Coordinates only – saves the coordinates of the sampled regions to a file with .RDS extension, this 

file can be later loaded by pressing the Load button. 

2. The Additional Data Fields block is used to indicate which data fields are to be included in the saved file. 

• Raw Filename: include the file name. 

• Raw Frame Number: include the frame number in raw file. 

• Cell Coordinates: include, in separate table columns, the coordinates of top left corner, the width 

and height of selected area. 

• Min/Max Values: include minimum/maximum values. 

• StdDev: include standard (root-mean-square) deviation values. 

• Average Green Channels: average the values of two green channels (this option is active only for 

RGBG files). 

Sample name and number, as well as average values for each channel, are always included. 

• Camera vendor/Camera model – includes the names of the camera manufacturer and camera 

model in the output CSV file. 

• Shutter value/Shutter string – information on the exposure will be included in the output CSV file: 

• Shutter value – exposure in seconds (for example 0.01). 

• Shutter string – exposure, in “pretty” format (for example, 1/100). 

• Aperture value/Aperture string – information about the aperture will be included in the output CSV 

file: 

• Aperture value – numeric value (for example 5.6) 

• Aperture string – “pretty” string (for example f/5.6) 

• ISO – the ISO speed value will be included in the output CSV file 

• Add DESCRIPTOR “DCP Profile” will add this string to output CGATS file (use this with BasicColor 

Input profiler to create DNG profile). 

3. Flat Field Normalization – to point to the file with Flat Field data that will be used to correct non-

uniformities. 

• FlatField Datafile – file, containing flat field data. 

• Average Channels - to average all channel data for the flat field correction data calculation. 

• Match Flat Field Data by Sample Name - for the flat field compensation, data between ffd file 

and target measurements is matched based on the patch names instead of line numbers. 



RawDigger User Guide 

Page 32 of 90 © Copyright 2012-2026, LibRaw LLC, www.libraw.com 

4. White Balance – output data will be white-balanced based on the readings from the patch indicated by 

Sample ID. Normally a neutral gray patch is used for the purpose; often the target manufacturer 

suggests the proper patch. White balancing is performed by multiplication of channel values for all 

patches by the coefficients that make the RGBG readings from the indicated patch equal.  

This setting can't be switched on for single channel (black and white) RAW files. 

5. Data Scaling and Gamma – output target data will be scaled and gamma-corrected: 

• Gamma Value – set the value of gamma, 0.1 to 4.0 

• Maximum Value – set the maximum value for the brightest patch (scaling is performed after patch 

data averaging) 

Flat Field Normalization, White Balance, Data Scaling, and Gamma are enabled only in RawDigger Profile 

Edition. 

Selection Grid: processing color targets 
As a routine while color profiling one needs to sample many color patches. This can be achieved by setting 

Selections manually and subsequently transforming Selections into Samples, but in RawDigger we offer a 

more productive and convenient method of processing the color targets. 

The Selection Grid is enabled only in the RawDigger Profile Edition. 

Grid-type selection is activated via menu: Selection->Selection Grid. You will be presented with the Grid 

Parameters dialog that allows controlling the grid parameters. 

 

Dialog parameters: 

• Grid Size: number of the cells that form the grid 

• Minimum cell size: the minimal number of pixels that compose the cell of the grid; while 

interactively changing the size of the grid this number limits the cell shrinking. 

• ROI relative size: the averaging of the values under the cell shall take part from the central portion 

of the cell, as defined by the region of interest, ROI, marked in red. ROI: the ratio of the cell side size 

(sell being displayed as the red rectangle) to the size of the side of sampling rectangle (this rectangle 

is displayed as gray). 
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• Grid settings button group (see below how to save and load grid settings): 

o Save to file – saves the current settings to a file.  

o Load from file – loads the grid settings from a file  

• In the Cell Naming tab, 

there are located settings to 

control grid cell naming: 

o Start from corner: 

to select the corner 

at which the first 

cell is placed 

o Walk order: the 

order in which the 

cells are numbered, 

column first or row 

first 

o Naming order: one of the 7 methods of cell naming 

o Show Cell ID/Name on Grid: to display (or not) the cell names  

• Place Grid: to place the grid on the screen 

o Use loaded position – uses the grid’s position if it was loaded from a file (this checkmark will 

only be available if the grid’s position was successfully loaded). 

• Remove Grid: to remove the grid from the screen 

• Selection to Samples: fills the Samples (deleting the old content if the checkbox to Clear Old 

Samples is set) 

• Hide Grid Controls: to hide the grid control dialog. 
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After the Place Grid button is pressed the main program window displays the grid. All the grid parameters 

except the Grid Size (grayed out) can be altered using the Grid Parameters dialog. 

 

You can move the grid on the screen: 

• Moving the corners: 

o While the left mouse button is pressed you can move one corner. 

o While Ctrl is pressed simultaneously with the left mouse button you can change the 

dimensions of the grid 

• To drag the whole grid set the mouse pointer to the center of the grid, press and hold the left 

mouse button and do a drag. 
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After the Selection to Samples button in Grid Parameters dialog is pressed the sample table is filled with the 

readings named in accordance with the cells naming scheme. 

 

You can process and save these readings in the usual manner (save as CSV or CGATS, delete table rows, 

display histograms of selected samples, etc.). 

The last set of Selection Grid parameters are automatically saved and reused when the program is restarted. 

Saving/Loading grid settings 

Grid Settings – Save to File button: 
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• This will save the grid settings to a file with an RGS extension, exactly as they are currently set in the 

grid settings dialog (Grid Size, Minimum cell size…). 

• If the grid is placed over an image, then the coordinates of its corners will be saved. 

Grid Settings – Load from File button: 

• This is active only if there is no grid on the screen (if there is one, use the Remove Grid button) 

• This will read all of the settings for the grid setting dialog from an RGS file, and apply them. 

• If the coordinates of a grid were recorded to the RGS file, then this will read them and the checkbox Use 

loaded position under the Place Grid button will become active. 

Place Grid button with the Use loaded position checkbox set: 

• If the pixel dimensions of the currently opened image file exactly correspond to the dimensions of the 

grid settings that were saved to the RGS file, then the grid will be placed exactly as recorded, “to the 

pixel.” 

• If the pixel dimensions of the current file differs from the one for which the grid was saved, then the grid 

will be set based on relative coordinates.  

When restoring the grid from the saved coordinates, the visible part of the screen scrolls so that the grid 

is visible (this is relevant when working with large zooms).  
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Raster Image Data Export 
Raster image data export allows saving data as a TIFF; it operates for the following types of data: 

• Results of RGB-render 

• All color channels of RAW file; resulting TIFF file will contain one, three or four channels, depending 

on the type of RAW  

• Separate color channel of the RAW file; exported as a monochrome TIFF 

Upon starting data export (Menu->File->Export Tiff), the following dialog is presented to the user: 

 

Export options, located below the file name input line, control the file export: 

Data section allows one to set the type of the data to be exported: 

1. RGB Render: this option sets the export to RGB. 

This option will be available if RGB rendition was calculated for the RAW file. If the option is 

unavailable, it is grayed out and unavailable for selection. 

If RGB option is selected, RAW and Bayer processing options are made unavailable. 

If the settings for Brighten are active, they are applied to the exported file, making it “brighter”. 

Data is exported into an 8-bit or 16 bit Tiff- file (see 16-bit output option below): 

a. Single channel (Grayscale), if the RAW file is recorded using monochrome camera. 
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b. 4-channel (interpreted by image processing software as CMYK), if the source RAW file is 4-

color (RGBE, CMYG, etc.) and the settings state “Display RGB Render in RAW colors”. The 

values in the file will be inverted with white coded as 0 and black coded as 255, as it is 

traditional for CMYK. 

c. 3-channel RGB-file in all other cases. 

 

2. RAW composite – the resulting TIFF will contain RAW data coming from all the color channels from 

the source RAW file. 

The data will be processed according to the settings in Raw processing and Bayer processing 

options (for Bayer type RAW files) sections. 

The result on the export is a 16-bit TIFF-file: 

a. Single channel (grayscale) for monochrome RAW files. 

b. Single channel (grayscale) for Bayer RAW, if in the Bayer Processing Options the mode 

“Single layer (Grayscale) pixel map” is set.  

c. 3-channel RGB or four channel RGBG if three-channel RGB output is chosen. 

d. 4-channel (non-inverted, white coded at full scale, black coded as 0) interpreted as CMYK 

“negative” for all other cases. 

 

3. Raw channel (you need to select the channel from the drop-down menu) – the output is 16-bit 

single channel (grayscale) TIFF file containing the selected color channel from the RAW file. 

Raw processing section allows setting the output processing options: 

1. 3-channel (RGB) output – two green channels of RGBG files will be averaged. 

This setting will be grayed out for non-RGBG files. 

2. Autoscale to use full 16-bit range – RAW data pixel values will be multiplied by a coefficient 

calculated so as to stretch the date to fill the whole 16-bit output range. 

For YCbCr data channels Y and Cb/Cr are scaled with different multipliers (for more details on YCbCr 

please see Show YCbCr data for Canon sRAW files in Settings section below). 

In all other cases the scaling multiplier is the same for all channels. 

3. Apply gamma 2.2 curve – if this option is “on”, the output is gamma-corrected to gamma 2.2, and if 

it is “off” the output contains linear data. 

Autoscaling and gamma-correction are rounding the values to integers. These options are better suited for 

visual inspection of data. If the data is to undergo numerical analyses, we recommend switching off all 

options in the RAW processing section. This way, it is guaranteed that the data is accurate.  

The Bayer processing section controls the output for Bayer-type 2 x 2 pattern RAW files. For all other types 

of RAW and pseudo-RAW files (monochrome, linear DNG, Canon sRAW) this section is unavailable. 

1. Half Size – 2 x 2 Bayer pattern will be binned and recorded as a single RGB pixel, and the resulting 

TIFF file will be half of the pixel dimensions of the censor. 

2. 2x2 pixels – the resulting file will be of full size, though pixel values in 2 x 2 patterns will be the 

same. 
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3. Fill missing values w/ zeroes – the resulting file will be of full size, but only the data presented in 

source RAW data will be meaningful, while all the missing values will be zeroed out. 

4. Single layer (grayscale) pixel map – This will be exported as a full-sized single channel (grayscale) 

file, where every pixel contains data corresponding to its pixel value in the matrix. The color 

information can be restored at a later stage of the user-supplied processing routine by taking the 

original Bayer pattern into account. 

This mode is intended for use with cameras in which the sensors have had the CFA removed 

(Meaning, originally “color” cameras, re-worked to monochrome). 

Additional export options: 

1. Uncompressed TIFF - to save an uncompressed TIFF file. 

2. 16-bit output: write RGB export as 16-bit TIFF file (RAW composite/channel export is always 16 bit). 

Note: 16-bit output available only in 64-bit version of RawDigger due to available memory 

restrictions. 

3. The option Add EXIF tags from RAW file allows copying the EXIF data from the source RAW file to 

the exported TIFF file. 

4. Embed ICC profile will embed ICC profile into resulting file (RGB rendering export only). 

5. Open exported file with default application – the resulting file will be opened by your default 

application associated with TIFF files. 

Data export as TIFF is available only in Research and Profile Editions of RawDigger. 

Processing of floating point data 
Starting with version 1.2, RawDigger supports DNG files containing floating point data. This format is used as 

an output by a number of programs that overlay several shots in order to extend the dynamic range and 

thus create HDR (High Dynamic Range) data. 

Unlike regular integer raw files, the data range in raw files containing floating point data can be very small, 

like (0..1) or quite large, (0..1000000). The range does not affect data processing, and is selected by the 

authors of the respective programs based mostly on convenience. 

Internally, RawDigger uses 16-bit unsigned integer data representation. Thus, the floating point data raw 

files are converted to internal RawDigger data format; and if the range of floating point data is too small or 

to large, normalization is performed (input floating point data is multiplied by a certain coefficient). 

Normalization is controlled through the settings in Floating point data normalization in Preferences – Data 

Processing 
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If the actual data range in the current raw file or the data maximum as it is set in metadata through 

WhiteLevel tag in DNG) exceeds the range “below XXX or above YYY”, all the pixel values (data numbers, 

DNs) in such a file will be multiplied by a constant, calculated in such a way that the new actual maximum 

will be equal to the value in the field ‘Scale data range to’. 

If upon opening a file such normalization was applied, the satus bar in RawDigger will contain ‘FP data 

normalized: the value of the multiplier used for normalization’: 

 

 

Please be careful: because of the normalization the shapes of the histograms of properly exposed and 

underexposed  shots will look similar because the multiplier for the underexposed file will be set to a larger 

value, «compensating» for the smaller actual maximum in raw data.   
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Preferences 
The Preferences window is accessed via the File menu or by pressing Ctrl-P in main program window. 

Available settings are grouped into three tabs: 

1. Display Options – for parameters that affect the data display but do not affect the raw values 

interpretation 

2. Data Processing – for parameters that affect the interpretation of the raw data 

3. File handling for settings that affect the opening / processing of files  

4. Misc. Options – for parameters controlling the behavior of the program, such as window positions 

preservation etc. 

5. Over/Under Exposure – the parameters that control the display of the over- and underexposed 

areas. 

The buttons at the bottom of the Preferences dialog behave in the same manner, whatever the current 

opened tab is: 

• OK: closes the Preferences window, saves the preferences in the Windows Registry and applies 

them to the currently loaded image, if any. 

• Cancel: closes the Preferences window without changing or saving the preferences. 

• Apply: saves the modified preferences and applies then to currently open images; does not close 

the Preferences window. 

• Reset Defaults: returns the Preferences window fields to their default values. 
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Display Options Tab 

 

RawDigger Preferences window: Display Options Tab 

The user preferences are arranged into the following groups: 

• Default Display Mode – to set the view mode for the next file to be opened. The values are: 

• Last Used – to use the same view mode as it was for the previous  

• RGB render – to view the processed raw (if this mode is not available for some reason the 

program defaults to Raw composite view mode) 

• Raw composite – to view RGB or Grayscale representation of all the channels in the raw file 

(please see below Display RGBG in grayscale mode) 

•  Raw Channel 1 .. Raw Channel 4 – the selected channel of the raw file will be displayed in 

grayscale. 

• RGB Render White Balance: white balance used to create RGB rendering. This parameter has no 

influence on the representation of the raw data in information blocks for the image and the 
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selected areas, neither in histograms nor in samples table. 

Three values of White Balance are possible: 

• Daylight: balance for daylight (the balance parameters in the program are “built-in”, 

separately for each camera). 

• As Shot: white balance as measured by the camera at the moment of shooting. 

• Auto: white balance calculated from the raw data. 

• Camera Auto/As shot: uses white balance recorded by camera WB sensor even if shot 

settings are different (so: shot set to some kind of manual WB). If the camera does not 

record the "Camera Auto" white balance, then the "As Ahot" setting  will be used as 

fallback. 

• UniWB: white balance multipliers are set to 1-1-1 

• Camera color profile: color profile used for RGB rendering. Again, this parameter does not affect 

raw data representation. Possible settings are: 

• No profile (raw color) – switches off color conversion between camera color space and 

sRGB. For 4-color cameras (CMYG, RGBE, etc.) data in this mode can’t be displayed, 

however the file with “untouched out-of-camera colors” can be obtained through data 

export (see Data Export section). 

• Built-in – use color profile provided within RawDigger 

• Embedded in RAW – use color profile embedded in RAW if present. If no such profile exists, 

RawDigger will fallback to 'Built-in' mode. 

• RGB rendering color space, choices are sRGB (default), Adobe RGB, Wide Gamut RGB, ProPhoto 

RGB. 

 RawDigger doesn't use color management, the output to screen is the direct one, the users of 

monitors set to emulate Adobe RGB or, more generally, wide gamut monitors may benefit from 

selecting Adobe RGB here; other options may turn useful if you want to display less saturated 

colors. 

• Visible area crop mode: selects visible (non-masked) area: 

• Minimal: use minimal crop, so maximal unmasked area (this mode was used in previous 

RawDigger versions) 

• Basic vendor crop: use vendor recommended crop. For DNG files: use DefaultCrop* tag 

values. 

• User crop: use more crop, for example: Aspect ratio crop used in Fujifilm cameras (for crops 

like 16:9 full RAW area is recorded and crop provided via metadata tags); DefaultUserCrop 

tag in DNG files (e.g. Leica in-camera crops). 

• RAW Display Options: control of the raw mode display. 

These parameters, same as the parameters for the RGB display, affect only the presentation of the 

image but not the “digital data”. 

• Masked Pixels: show the masked part of the camera sensor, which does not participate in 

the image formation (some manufacturing companies use the name Optical Black instead of 

Masked Pixels). This part of the sensor is masked from light; hence, in some cases it is 

possible to estimate the noise level in the deepest shadows, the banding level and to 

calculate the black level. The invisible (masked) pixels are not included in the raw image in 

some cameras. 
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• 2x2 Pixels: stretches each single-color (Bayer) pixel to the size of 2x2, making it possible to 

obtain an image more resembling the results after demosaicking. The figure below shows 

the result when this parameter is switched off: 

 
Fig. 6. White field shown in RAW mode with 2x2 Pixels set to ON (left) and OFF (right). 

When the 2x2 Pixels mode is set to off, it is closer to reality for a Bayer sensor but moiré-

prone on screen, unpleasant for the eye and the resultant picture is much darker. 

In the figure above, the white field looks green, since the white balance in not used in the 

raw viewing mode and the green channel in most cameras is more sensitive than other 

color channels. 

For the full-color and black-and-white RAW files (that is for the files with each pixel 

containing full information) this setting is ignored (processed as Off). 

• Gamma 2.2: sets gamma correction for raw data. Without this correction, the image looks 

dark. 

• Autoscale: sets the automatic scaling of raw data to the display the brightness range. 

Without this scaling, the image in the raw viewing mode will look very dark. 

• Display RGBG in grayscale  - all pixels in the raw file will be displayed using grayscale 

instead of their «colors». This mode is incompatible with 2x2 pixels display mode. 

If the file contains raw channels different from RGB(G), Raw Composite view mode will be 

substituted with grayscale, independent of the setting for Display RGBG as Grayscale. 

For non-Bayer (full-color) RAW files this setting is always processed as Off. 

• Mouse Pointer: parameters for displaying the raw value under the mouse cursor. 

• 2x2 Active Area: if this option is on, the window with the values under the mouse cursor 

shows the pixel values in a 2x2 square around the pointer (the Bayer sensor contains pixels 

of all 4 channels in that square). 

If this option is off, only the values corresponding to the pixel directly below the pointer are 

shown and the remaining three components are zero. 

For the full-color and black-and-white RAW files (that is for the files with each pixel 

containing full information) this setting is ignored (processed as Off). 

• Automatic exposure correction for RGB render: turns on the automatic brightness correction of 

RGB representation. 
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• Allow autoexposure to clip % (highlights) controls the relative amount of pixels that can be 

clipped when autoexposure is applied, and thus it controls the amount of lightening applied 

through autoexposure. 

• Override white level: Allows to set white level used for rendering to user-specified value. 

• Disable RGB rendering for files larger than NN Mpix:  disables RGB rendering and RGB display for 

large files which are too large. You can set these limits as you wish, but for 32-bit systems it is 

impractical to render RGB for 40Mpix or larger files, because memory is limited on these systems. 

• Disable processing for files larger than NN mbytes of RAW data: disables loading of too large RAW 

files to avoid memory overuse.  This setting is limited to: 

• 8GB for x86/64 bit CPUs (for both Mac and Windows) 

• 4GB for Apple Silicon (M1) CPUs (Mac only) 

• 1GB for Windows/32 bit version. 
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Data Processing Tab 
Parameters in this tab do affect the representation of raw values in windows with statistical data, 

histograms and samples table. 

 
 

Raw Digger Preferences window: Data Processing Tab 

The current version of RawDigger contains the following Data Processing parameters: 

• Subtract Black: to subtract the “black level” (that is, the “dark current” value). The actual value to 

be subtracted is set in the Black Level block (see below). 

• Linear Raw Curve: to use the linear tone curve instead of the nonlinear (compression) one. This 

parameter is important only for cameras and data formats that use the tone curve specified in EXIF 

data for raw data linearization (e.g., a significant number of Sony cameras). 

• Selection/Sample stats: discard abnormal pixel values: if this setting is on (checkbox set), statistics 

for Selection and Sample discards 10% of highest and 10% of lowermost pixel values to filter off 

dust, scratches, small specular reflections, and other target/sensor defects. 
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This mode is useful for creating measurements files from the shots of the profiling targets. It 

automatically filters off certain target and sensor defects to make measurement more meaningful. 

This mode is available only in RawDigger Profile Edition. 

• Black Level: preferences for black subtraction mode. 

These preferences can be formally attributed to the Data Processing block; however, since there are 

many customizable parameters here, this block is described separately. 

• Auto: the black level is set automatically. Depending on the file format, it will be either read 

from the EXIF data or calculated according to the black frame. 

• Manual: the black level is set manually; identical values are set for all channels. 

• Per Channel: the black level is set manually; different values for each channel are allowed. 

o Reset Black Level values on File Load: when the next file is opened, the black level in the 

Manual and Per Channel input fields is set in accordance with the Auto variant but can be 

manually changed afterwards. 

• For the automatically set Subtract Black Level, if BlackLevelRepeat* tag in DNG (or an analogous tag 

in files for Fuji X-Trans sensors) is present RawDigger takes the black level from large blocks (up to 

64x64). 

When manually setting the black level, (shared or by color channel) the aforementioned complex 

black level setting patterns are not used. 

• Floating Point Data Normalization groups: 

• For data maximum below … or above … -  if the actual data range _or_ the value of the 

maximum in the DNG file are out of this range. 

• Scale data range to – then all the data numbers (pixel values) will be multiplied by the same 

coefficient, to make the actual  maximum equal to value set in this field. 

See section Processing of floating point data above for details. 
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Data Processing -> Vendor specific Tab 
Settings related to specific data formats or manufacturers only (that is,   Sony ARW2, Panasonic, PhaseOne, 

Sigma dp2 Quattro, Canon/Nikon sRAW/Small RAW) 

 

Raw Digger Preferences window: Data Processing -> Vendor specific Tab 

• Sony ARW2 processing options – turns on special modes for processing lossy-compressed Sony 

ARW2 (cRAW): 

o None (standard processing) – the data will be processed standardly 

o Only base pixels – only the base pixel are used for output (the base pixels are the minimum 

and maximum for each color channel on a horizontal 32-pixel block). The values of other 

pixels ("delta-pixels") coded as rounded deltas from the minimum value in the block are set 

to zero. 

o Only delta pixels – only the "delta pixels" are used for the output (with "base" minimum 

value added to them), base pixels are set to zero so as to output only the delta pixels. 

o Delta pixels relative to zero – same as above but base minimum values are not added. 
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o Delta step relative to value – the output is the ratio of delta step to RAW value of the pixel. 

The units are pro mil (one per thousand). Those areas with large values of the ratio are the 

candidates for exhibiting posterization. 

▪ Ignore shadows below level – do not compute / display Delta step relative to value 

for the image areas where the RAW value is lower than this setting (deep image 

shadows are characterized by relatively large step values and so those areas are 

obvious candidates for posterization; while excluding such areas from the display of 

posterization helps to avoid display congestion. 

Turning on any mode except None forbids using the RawSpeed library. 

Turning on the "Delta pixels relative to zero" mode turns off the use of RawSpeed and Subtract 

Black Level, and additionally turns on Linear Tone Curve. 

• Show YCbCr data for Canon/Nikon sRAW files: switches off the conversion of YCbCr data contained 

in Canon sRAW/Nikon D4s small RAW (NEF Size S) to RGB. The brightness in channel Y is provided as 

is. For Canon cameras, Cb/Cr channels are shifted by subtracting 8192 to place achromatic “gray 

point” for Cb/Cr channels in the middle of the range. 

Gamma correction is not applied to Cb/Cr channel data irrespective of the gamma setting in Display 

Options tab. 

For YCbCr data histogram, the display is set to show X-axis in EV scale, that is logarithmic rule. The 

user can switch it to linear rule if desired. 

• Do not interpolate Cb/Cr channels data (Canon/Nikon sRAW) 

The values for Cb/Cr channels in sRAW files are not defined for all pixels, but only in every second or 

every forth pixel. Before conversion to RGB the missing values for Cb/Cr channels are interpolated. 

This option allows switching off such interpolation.  

The option is available only together with the option Show YCbCr data for Canon/Nikon sRAW files. 

• Phase One RAW postprocessing: switches raw data processing on and off based on metadata in raw 

file (bad pixels map, additional tonal curves, etc.) 

This setting does not affect the display in 'RGB render' mode. 

• Pentax K3-II  

• Merge data for 4-shot frames  - turns on merging of 4 subframes in 4-shot files 

• Sigma dp2 Quattro options: 

• R and G channels interpolation turns on the duplication of pixels in the  R and G channels to 

form a 2x2 square. 

• "Low sensitivity pixel interpolation" – turns on the normalization of   pixels with lower 

sensitivity found in the R and G channels (in the dp2 Quattro camera, every 64th pixel in the 

R and G channels has a sensitivity lowered by about 2 stops. What these pixels are used for 

is currently not certain, possibly for exposure control in overexposed areas). 

• Canon CR3/CRM files options: 

• Refuse CR3/CRM files larger than 4GB (default: not checked) 

• Limit CR3/CRM frames to:  (default: 128 frames, range 32...16384) 

 Both options limit the processing of (very large) files: either by size or by the number of 

frames read.These options are mutually exclusive. 

• Filter bad pixels on Panasonic files: this enables the filtering off for bad pixels in the raw files from 

Panasonic and some other cameras (the files contain zeros in the place of bad pixels). 
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• Nikon Coolscan NEF files gamma: allows to set gamma value to Coolscan files according to scanning 

settings. 

• DNG Files 

• Apply DNG Opcodes: what DNG opcodes should be applied to get RAW data (if such 

opcodes are present in the DNG file) 

• Additional image types:  to allow the display of the secondary images contained in DNG file: 

Enhanced frame (that corresponds to Adobe Camera RAW/Lightroom: Enhance image), 

Previews (low-resolution/lossy compressed images) and Transparency masks. 
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Histograms Tab 

 

RawDigger Preferences window: Histograms Tab 

• Histogram Scale – sets the horizontal scale for histogram window: 

• Last Used – the histogram is shown with the settings from the previous  

• EV Scale (Photographic) – photographic EV scale will be used  

• Linear Scale – linear scale will be used. 

• Remember scale ranges: to store the settings for the histogram window (range of values, grid on 

vertical and horizontal axis).  

If this option is on the very last change made to any of histogram windows will be stored.  

The settings stored here will be used when opening new histogram windows. Any change of 

parameters in one histogram window does not affect other histogram windows. 

• Histogram for RGBG bayer images – controls the number of per-channel histograms for regular 

Bayer-type 2x2 raw data (2 green, 1 red, and 1 blue in a 2x2 pixel square): 

• Display G1 and G2 – separate histogram for each of green channels are displayed. 
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• G1 only – only the histogram of the first green channel is displayed; the histogram for the 

second green channel is omitted. 

• Average G1 and G2 – an averaged histogram is displayed: 

i. Bar heights – average between 2 green channels. 

ii. Statistics minimum and maximum – absolute minimum and maximum of the data 

collected from both green channels. 

iii. Number of unique values – the number of unique values found in the green channel 

where it is larger. 

iv. Number of of pixels – an average between both green channels. 

• Additional data in Histogram title bar – controls the display of additional shooting information on 

the title bar of the histogram window 

• None – no additional data is displayed. 

• Exposure data – shutter speed, lens aperture, and ISO speed are displayed. 

• Camera model – the make and the model of the camera are displayed. 

• Exposure & Camera – both exposure data and camera model from previous is displayed. 

• Set Histogram EV0 by – sets the choice of the maximum value that is used for automatic calculation 

of midpoint (EV0). EV0 is calculated as 3 stops below the chosen maximum: 

• Current frame data – maximum value found in the currently opened frame is used. 

• Camera data range – maximum value is determined by the raw data bit width (theoretically 

possible range). (Some cameras will not use the whole range; for some cameras the range 

changes with the change of ISO speed setting). 

• Set linear histogram auto range – sets the choise of the data scale used in histogram linear mode: 

• Current frame data – maximum value found in the currently opened frame is used. 

• Camera data range – maximum value is determined by the raw data bit width (theoretically 

possible range). (Some cameras will not use the whole range; for some cameras the range 

changes with the change of ISO speed setting). 

• Histogram area font family – sets font used for graphics histogram area (axis values, statistics, etc). 

• HiDPI histogram window mode – doubles the resolution of the histogram window display. This 

mode is recommended primarily for HiDPI monitors used with Apple Mac. 

• High resolution histogram PNG export – doubles the resolution when exporting the histograms to 

PNG files. 

• (Windows Only) Histogram windows always on top of main window – in this mode the histogram 

windows are always on top of the main program window.  
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File Handling Tab 
This tab contains settings that affect the opening / processing of files 

 

• If next file load fails, move current filename pointer forward – this setting controls RawDigger 

behavior if next file (via Menu – File – Next/Prev file, or via Ctrl-Arrow keys) load fails for whatever 

reason. With the checkbox on, RawDigger will allow subsequent Next/Prev file actions to count 

from new (failed to load) current file. 

• Warn about unsaved Samples on File Open/Exit.  

To switch unsaved sample on/off data warning. 

• Remember Working Folder: to set the folder (directory) of the last opened raw file as working; next 

Open/Save dialogs will start in that working folder.  

The setting is in effect for all consequent RawDigger runs, until re-defined. 

• Unload opened file before loading new one: if this setting is active the file that is currently opened 

will be closed to free the memory.  

This mode is useful while processing very large (40-50Mpix and more) files.  

If this setting is active all samples and selections are not inherited for the new file. 
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• Use native system file open/save dialogs where possible – open/save file dialogues (except those 

dialogs with additional parameters), will use “native system dialogs” (the ones that are like those in 

Windows Explorer/Mac Finder). 

• File Sort order for Next/Prev: to set the sorting order for Next file/Prev file operations: 

• Name: sort by the file name. 

• Modify time: sort by the file time stamp. 

• Size: sort by the file size. 

• Unsorted: files are sorted by the operational system, usually in the order they arrived in the 

directory. 

• Use natural sort order – when sorting by filename, a natural sort order will be used with numericals 

(e.g., the order of files will be a1.ext a2.ext a10.ext). When this is turned off, an alphabetic sort 

order will be used (a1.ext a10.ext a2.ext). 

• Sidebar folders in “Save…” dialogs: The user can now control the set of folders, which is displayed 

in the Sidebar of the “Save…” dialogs (that is, export of RAW data and saving the measurement 

tables). The choices are:  

• Remember used folders: to display the list of previously used folders ("traditional" 

behavior).  

• Standard list: include only Desktop, Documents, Pictures, TEMP, and Home folder. 

• Home Folder only 

• Additional RAW extensions – to add extensions to the list of the file extensions known to 

RawDigger by default. These additional extensions will be allowed for Open and Prev/Next raw file 

open operations. The list of additional extensions is of the form of file name masks separated with a 

space, like *.tif *.bin. 

  



RawDigger User Guide 

Page 55 of 90 © Copyright 2012-2026, LibRaw LLC, www.libraw.com 

Misc. Options Tab 
This tab contains the settings that affect the program’s behavior, but do not directly affect data processing 

or data display. 

 

Raw Digger Preferences dialog, Misc. Options tab 

• Save windows positions on exit: to store the position and dimensions of all the program windows 

on program exit. The positions and dimensions of the windows will be restored upon next program 

start; that is – when the program starts only the main window is opened, but when additional 

histogram and samples windows are created they will be positioned and sized according to the 

saved settings. 

• Use Regional Settings for decimal separator: Enables the use of the System Regional Settings to set 

the decimal separator. (Control Panel - regional Settings - Country). If those are set to use comma as 

the decimal separator - semicolon will be used as the field delimiter in CSV files. 

If the "Use Regional Settings" is turned off a period will be used as the decimal separator. 
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• Run single Program Instance (Windows only): to prevent running multiple copies of the program. 

While in this mode,  

• If a new RawDigger process is started while the raw file name is passed to RawDigger as a 

command line parameter the file will be opened in the already existing program window. 

• New RawDigger process will be immediately terminated after that. 

• Faster program close (Windows only) – turns on faster program exit (resources are not released, 

operating system will do it for us). 

• Use small fonts in information panels – decreases the font size and shrinks the gaps between the 

informational panels in the upper part of the program window. Useful for the lower resolution 

displays. 

• Put grid setup dialog on top of all windows (Profile edition only) – makes Grid Setup window 

floating other all windows of all programs running. 

• Minimize subwindows together with main window – If this setting is enabled, minimizing the main 

program window will also cause minimization of all other windows. 

• Use OpenGL for bitmap draw – when this setting is turned on, OpenGL will be used to display 

images. This may work faster on computers with old CPUs. 

• This settign is unavailable in Legacy versions. 

• Place EXIF button on bottom bar – cleans space in metadata area by moving EXIF button on the 

program bottom bar  (this setting will take effect after program restart). 

• Optional RAW decoders – controls usage of optional RAW format decoders (besides LibRaw): 

• Adobe DNG SDK: 

i. Exotic DNG formats: Use Adobe DNG SDK for 8-bit files and floating-point files 

ii. All DNG formats:  Use Adobe DNG SDK for all DNG files 

• RawSpeed V1/V2 (RawSpeed opensource library decodes some formats much faster then 

LibRaw but has limited file format support): 

i. Use:  use the decoder 

ii. Also for unknown cameras: use for all possibly supported cameras, not only 

explicitly listed in RawSpeed camera definitions file 

iii. Check for warnings: check for RawSpeed reported warnings and display them to the 

user. 

• ExifTool Settings: path to ExifTool utility and parameters to control it: 

• Path: the path to ExifTool executable module. The value is set during the install of 

RawDigger, but if you have a version of ExifTool that you prefer (for example, a more recent 

one) you can set the path to point to that version. 

• Command Line: parameters for ExifTool command line. RawDigger will pass those 

parameters to ExifTool adding –h for HTML output. 

• Check for updates: this parameter schedules the checks for updates - at each program launch or 

once in every 1-3-7-15-30 days. 

• Sampler Settings: sampler tool preferences 

• Sampler Size: selection of the sampling size area from a list (2x2, 6x6, 10x10, 18x18, 34x34, 

66x66). 

If you need a nonstandard sampling size, you can perform manual selection (Selection) and 
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then convert it to a sample (menu item Selection -> Convert Selection to Sample). 

Sampler Size Control is available only in Research и Profile editions of RawDigger. 

Over/Under Exposure tab 
This tab allows adjusting the settings that control how the areas of underexposure and overexposure are 

defined. 

 

• Overexposure Detection: to control how the overexposure (saturation, blow-out) are defined 

o Auto (by Histogram): overexposure is determined by the analysis of the peaks on the 

histogram using the area of extreme highlights. 
o Sensitivity – the width of the area designated as overexposure 

▪ Value on percent (from the whole range of values offered by the camera) - sets the 

search radius for the sharp histogram peak.  
▪ Full Well limited camera - turns on an alternative algorithm of finding overexposure 

by the "fuzzy hump". This mode is intended for use with cameras, where the target 
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RAW-values are not limited by ADC but use close to the whole range of the sensor 

values. 
o Auto OE Offset – lets you change the values set by the automatic algorithm. The shift must 

be set in photographic stops; negative shift lowers the boundary for detecting 

overexposure, positive shift raises it. 
o Manual level, all channels: to set the single overexposure value for all color channels. 
o Manual per channel: to set overexposure levels for each color channel independently. 
o Reset Manual levels on file load: to use automatically computed (Auto, by histogram) levels 

when loading a new file; the computed levels will be set into the “manual” fields and used 

as such. 
o Use camera linearity limit if available: If this setting is on, for the cameras with 

recommended raw maximum white value contained in metadata this value takes 

precedence when detecting overexposure. 

• Underexposure Detection: the settings which control how the areas of underexposure are 

determined 
o Offset from Saturation: the underexposure level is defined as an offset (in EV) relative to 

overexposure (saturation) level. 

If while setting the level of overexposure the shift from the automatic level was used, this 

same shift will be used for the underexposure boundary. 
o Manual level, all channels: to set the single underexposure level for all color channels. 

o Manual, per channel: to set the underexposure levels independently for each color 

channel. 

• Remember OvExp/UnExp checkbox settings: to store the settings for over- and underexposed 

areas display. 

Support of non-standard cameras 
RawDigger can be used for the display and analysis of images from “engineering” cameras, which are saved 

in the form of “sensor data dumps” without any other additional metadata. 

A series of such cameras are already directly supported by the program (RawDigger contains an internal 

table with the necessary data); to support other (arbitrary) sensors, one has to add a description of the 

structure of the sensor’s data into the Windows Registry (on Windows) or OS X defaults (on Mac OS X). 

To do this one must: 

Windows: prepare a registry-script with content similar to the following: 

[HKEY_CURRENT_USER\Software\LibRaw LLC\CustomCameras] 

"Camera01"="24096096,4008,3006, 0, 0, 0, 0,0,148,0,0,Dalsa, FTF4052C 4:3,0" 

And run it in Windows Explorer. 

OS X: run a command in the Terminal, similar to the following one-liner: 

defaults write com.libraw-llc.CustomCameras "Camera01" "24096096,4008,3006, 0, 

0, 0, 0,0,148,0,0,Dalsa, FTF4052C 4:3" 
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In both cases: 

Camera01 (or Camera02 … Camera64) – the “number line” in the table, up to 64 records of this type are 

supported. 

The line “24096096,4008,3006, 0, 0, 0, 0,0,148,0,0,Dalsa, FTF4052C 4:3,0” defines the format of the 

camera’s data and consists of 14 fields separated by commas (a note for engineers: the format of this line is 

completely analogous to the line in the “sensor dump” table’s description in dcraw.c with the one 

difference being that the CFA filter’s format is set in base 10): 

1. The exact size of the file in bytes (in this example – 24096096). This is the only criterion by which 

RawDigger recognizes a data “format”, files of a different size will be ignored. 

2. The width of the sensor in pixels. Put the entire width, including the “black frame” in this field. 

3. The height of the sensor in pixels, including the black frame. 

4. The width of the black frame at the left edge of the sensor (in pixels) 

5. The width (height) of the black frame at the top. 

6. The width of the black frame at the right edge. 

7. The width (height) of the black frame at the bottom. 

8. Additional parameters for the file decoding subprogram (see below). 

9. The Bayer filter CFA format, with the byte field taking one of the following values: 

• 22 – BGGR 

• 97 – GRBG 

• 73 – GBRG 

• 148 – RGGB 

• 180 - GMYC 

10. The amount of unused bit data (for example, if 14-bit data is recorded in a 16-bit format) 

11. Additional metadata, bit mask. 

a. Bit 0 – find a .JPG file with the same name and read the EXIF data from it. 

b. Bit 1 – filter (average neighbors) for pixels with values of zero 

c. Bits 2-4 – the orientation of the image (0=do not rotate, 3=180, 5=90CCW, 6=90CW) 

12. Camera manufacturer 

13. Camera model 

14. The offset of the beginning of the sensor data from the beginning of the file (the value range is 0-

65534, the special value 65535 means that “the rows are going in the opposite direction”). 

8, 10, 12, and 16-bit data formats are supported, the amount of bits is calculated as (the size of the file 

minus the offset from the beginning of the data)/number of pixels. 

Depending on the bit-ness of the data, the 8th field (“additional parameters for the file decoding 

subprogram”) can accept the following values for 10-bit data: 

• 1: “4 pixels in 5 bytes” packing is used 

• 0: “6 pixels in 8 bytes” packing is used 
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Supported Cameras 
For the list of supported cameras please see below.  

RawDigger can operate with some other cameras that are not yet listed; however we can't guarantee that 

the results will be accurate. For those cameras that are not fully supported the colors may be wrong as 

displayed in RGB-render mode, also the width of the masked zone can be off; etc. 

• ASUS  

o ZenPhone4 

o ZenPhone6 

• AVT  

o F-080C 

o F-145C 

o F-201C 

o F-510C 

o F-810C 

• Adobe Digital Negative (DNG) 

• AgfaPhoto DC-833m 

• Alcatel 5035D 

• Apple  

o iPad Pro 

o iPhone SE 

o iPhone 6s 

o iPhone 6 plus 

o iPhone 7 

o iPhone 7 plus 

o iPhone 8 

o iPhone 8 plus 

o iPhone X 

o iPhone 12 Pro 

o iPhone 12 Pro Max 

o iPhone 13 

o iPhone 14 

o iPhone 14 Plus 

o iPhone 14 Pro 

o iPhone 14 Pro Max 

o iPhone 15 

o iPhone 15 Plus 

o iPhone 15 Pro 

o iPhone 15 Pro Max 

o QuickTake 100 

o QuickTake 150 

o QuickTake 200 

• AutelRobotics  

o XB015 

o XT705 (EVO II) 

o XL720 (EVO Lite+) 

• BQ Aquarius U 

• Baumer TXG14 
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• BlackMagic  

o Cinema Camera 

o Micro Cinema Camera 

o Pocket Cinema Camera 

o Production Camera 4k 

o URSA 

o URSA Mini 4k 

o URSA Mini 4.6k 

o URSA Mini Pro 4.6k 

• CLAUSS pix500 

• Canon  

o PowerShot 600 

o PowerShot A5 

o PowerShot A5 Zoom 

o PowerShot A50 

o PowerShot A410 (CHDK hack) 

o PowerShot A460 (CHDK hack) 

o PowerShot A470 (CHDK hack) 

o PowerShot A480 (CHDK hack) 

o PowerShot A530 (CHDK hack) 

o PowerShot A540 (CHDK hack) 

o PowerShot A550 (CHDK hack) 

o PowerShot A560 (CHDK hack) 

o PowerShot A570 IS (CHDK hack) 

o PowerShot A590 IS (CHDK hack) 

o PowerShot A610 (CHDK hack) 

o PowerShot A620 (CHDK hack) 

o PowerShot A630 (CHDK hack) 

o PowerShot A640 (CHDK hack) 

o PowerShot A650 IS (CHDK hack) 

o PowerShot A710 IS (CHDK hack) 

o PowerShot A720 IS (CHDK hack) 

o PowerShot A3300 IS (CHDK hack) 

o PowerShot D10 (CHDK hack) 

o PowerShot ELPH 130 IS / IXUS 140 / IXY 110F (CHDK hack) 

o PowerShot ELPH 160 / IXUS 160 (CHDK hack) 

o PowerShot Pro70 

o PowerShot Pro90 IS 

o PowerShot Pro1 

o PowerShot G1 

o PowerShot G1 X 

o PowerShot G1 X Mark II 

o PowerShot G1 X Mark III 

o PowerShot G2 

o PowerShot G3 

o PowerShot G3 X 

o PowerShot G5 

o PowerShot G5 X 

o PowerShot G5 X Mark II 
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o PowerShot G6 

o PowerShot G7 (CHDK hack) 

o PowerShot G7 X 

o PowerShot G7 X Mark II 

o PowerShot G7 X Mark III 

o PowerShot G9 

o PowerShot G9 X 

o PowerShot G9 X Mark II 

o PowerShot G10 

o PowerShot G11 

o PowerShot G12 

o PowerShot G15 

o PowerShot G16 

o PowerShot S2 IS (CHDK hack) 

o PowerShot S3 IS (CHDK hack) 

o PowerShot S5 IS (CHDK hack) 

o PowerShot SD300 / IXUS 40 / IXY Digital 50 (CHDK hack) 

o PowerShot SD750 / IXUS 75 / IXY Digital 90 (CHDK hack) 

o PowerShot SD900 / Digital IXUS 900 Ti / IXY Digital 1000 (CHDK hack) 

o PowerShot SD950 IS / Digital IXUS 960 IS / IXY Digital 2000 IS (CHDK hack) 

o PowerShot SD1200 IS / Digital IXUS 95 IS / IXY Digital 110 IS (CHDK hack) 

o PowerShot S30 

o PowerShot S40 

o PowerShot S45 

o PowerShot S50 

o PowerShot S60 

o PowerShot S70 

o PowerShot S90 

o PowerShot S95 

o PowerShot S100 

o PowerShot S110 

o PowerShot S120 

o PowerShot SX1 IS 

o PowerShot SX40 HS (CHDK hack, CR2) 

o PowerShot SX50 HS 

o PowerShot SX60 HS 

o PowerShot SX70 HS 

o PowerShot SX100 IS (CHDK hack) 

o PowerShot SX110 IS (CHDK hack) 

o PowerShot SX120 IS (CHDK hack) 

o PowerShot SX130 IS (CHDK hack) 

o PowerShot SX160 IS (CHDK hack) 

o PowerShot SX220 HS (CHDK hack) 

o PowerShot SX510 HS (CHDK hack) 

o PowerShot SX710 HS (CHDK hack) 

o PowerShot SX10 IS (CHDK hack) 

o PowerShot SX20 IS (CHDK hack) 

o PowerShot SX30 IS (CHDK hack) 

o PowerShot V1 
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o EOS R 

o EOS Ra 

o EOS RP 

o EOS R1 

o EOS R3 

o EOS R5 

o EOS R5 C 

o EOS R5 Mark II 

o EOS R6 

o EOS R6 Mark II 

o EOS R6 Mark III 

o EOS R7 

o EOS R8 

o EOS R10 

o EOS R50 

o EOS R50 V 

o EOS R100 

o EOS D30 

o EOS D60 

o EOS 5DS 

o EOS 5DS R 

o EOS 5D 

o EOS 5D Mark II 

o EOS 5D Mark III 

o EOS 5D Mark IV 

o EOS 6D 

o EOS 6D Mark II 

o EOS 7D 

o EOS 7D Mark II 

o EOS 10D 

o EOS 20D 

o EOS 20Da 

o EOS 30D 

o EOS 40D 

o EOS 50D 

o EOS 60D 

o EOS 60Da 

o EOS 70D 

o EOS 77D / 9000D 

o EOS 80D 

o EOS 90D 

o EOS 100D / Rebel SL1 / Kiss X7 

o EOS 200D / Rebel SL2 / Kiss X9 

o EOS 250D / 200D II / Rebel SL3 / Kiss X10 

o EOS 300D / Digital Rebel / Kiss Digital 

o EOS 350D / Digital Rebel XT / Kiss Digital N 

o EOS 400D / Digital Rebel XTi / Kiss Digital X 

o EOS 450D / Digital Rebel XSi / Kiss X2 

o EOS 500D / Rebel T1i / Kiss X3 
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o EOS 550D / Rebel T2i / Kiss X4 

o EOS 600D / Rebel T3i / Kiss X5 

o EOS 650D / Rebel T4i / Kiss X6i 

o EOS 700D / Rebel T5i / Kiss X7i 

o EOS 750D / Rebel T6i / Kiss X8i 

o EOS 760D / Rebel T6S / 8000D 

o EOS 800D / Rebel T7i / Kiss X9i 

o EOS 850D / Rebel T8i / Kiss X10i 

o EOS 1000D / Digital Rebel XS / Kiss F 

o EOS 1100D / Rebel T3 / Kiss X50 

o EOS 1200D / Kiss X70 / REBEL T5 / Hi 

o EOS 1300D / Rebel T6 / Kiss X80 

o EOS 1500D / 2000D / Rebel T7 / Kiss X90 

o EOS 3000D / 4000D / Rebel T100 

o EOS D2000 

o EOS C50 

o EOS M 

o EOS M2 

o EOS M3 

o EOS M5 

o EOS M6 

o EOS M6 Mark II 

o EOS M10 

o EOS M50 / Kiss M 

o EOS M50 Mark II / Kiss M2 

o EOS M100 

o EOS M200 

o EOS-1D C 

o EOS-1D X 

o EOS-1D X Mark II 

o EOS-1D X Mark III 

o EOS-1D 

o EOS-1D Mark II 

o EOS-1D Mark II N 

o EOS-1D Mark III 

o EOS-1D Mark IV 

o EOS-1Ds 

o EOS-1Ds Mark II 

o EOS-1Ds Mark III 

• Casio  

o QV-2000UX (secret menu hack) 

o QV-3000EX (secret menu hack) 

o QV-3500EX (secret menu hack) 

o QV-4000 (secret menu hack) 

o QV-5700 (secret menu hack) 

o QV-R41 

o QV-R51 

o QV-R61 

o EX-F1 
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o EX-FC300S 

o EX-FC400S 

o EX-FH20 

o EX-FH25 

o EX-FH100 

o EX-S20 / M20 

o EX-S100 

o EX-Z4 

o EX-Z50 

o EX-Z500 

o EX-Z55 

o EX-Z60 

o EX-Z75 

o EX-Z750 

o EX-Z8 

o EX-Z850 

o EX-Z1050 

o EX-ZR100 

o EX-Z1080 

o EX-ZR700 

o EX-ZR710 

o EX-ZR750 

o EX-ZR800 

o EX-ZR850 

o EX-ZR1000 

o EX-ZR1100 

o EX-ZR1200 

o EX-ZR1300 

o EX-ZR1500 

o EX-ZR3000 

o EX-ZR3100 

o EX-ZR3200 

o EX-ZR3500 

o EX-ZR3600 

o EX-ZR3700 

o EX-ZR4000 / 5000 

o EX-ZR4100 / 5100 

o EX-100 

o EX-100F 

o EX-100PRO 

o EX-10 

o EX-P505 (secret menu hack) 

o EX-P600 (secret menu hack) 

o EX-P700 (secret menu hack) 

• Contax N Digital 

• Creative PC-CAM 600 

• DJI  

o 4384x3288 

o Inspire 3 
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o Mavic Air 

o Mavic Air 2 

o Mavic Air 2S 

o Mavic Air 3 

o Mavic Mini 2 

o Mavic Mini 3 

o Mavic Mini 3 Pro 

o Mavic 2 Pro 

o Mavic 3 

o Mavic 3 Classic 

o Mavic 3 Pro 

o Osmo Action 

o Pocket 

o Phantom4 Pro/Pro+ 

o Zenmuse X5 

o Zenmuse X5R 

• DXO One 

• Digital Bolex  

o D16 

o D16M 

• Epson  

o R-D1 

o R-D1s 

o R-D1x 

• Eyedeas E1 

• Foculus 531C 

• FujiFilm  

o DBP for GX680 / DX-2000 

o E550 

o E900 

o F500EXR / F505EXR 

o F550EXR 

o F600EXR / F605EXR 

o F700 

o F710 

o F770EXR / F775EXR 

o F800EXR 

o F810 

o F900EXR 

o S2Pro 

o S3Pro 

o S5Pro 

o S20Pro 

o S1 

o S100FS 

o S5000 

o S5100 / S5500 

o S5200 / S5600 

o S6000fd / S6500fd 
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o S7000 

o S9000 / S9500 

o S9100 / S9600 

o S200EXR / S205EXR 

o SL1000 

o HS10/HS11 

o HS20EXR / HS22EXR 

o HS30EXR / HS33EXR / HS35EXR 

o HS50EXR 

o GFX 50S 

o GFX 50S II 

o GFX 50R 

o GFX 100 

o GFX 100 II 

o GFX 100RF 

o GFX 100S 

o GFX 100S II 

o X-Pro1 

o X-Pro2 

o X-Pro3 

o X-S1 

o X-S20 

o XQ1 

o XQ2 

o X100 

o X100F 

o X100S 

o X100T 

o X100V 

o X100VI 

o X10 

o X20 

o X30 

o X70 

o X-A1 

o X-A2 

o X-A3 

o X-A5 

o X-A7 

o X-A10 

o X-A20 

o X-E1 

o X-E2 

o X-E2S 

o X-E3 

o X-E4 

o X-E5 

o X-M1 

o X-M5 
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o XF1 

o XF10 

o X-H1 

o X-H2 

o X-H2S 

o X-T1 

o X-S10 

o X-T1 Graphite Silver 

o X-T2 

o X-T3 

o X-T4 

o X-T5 

o X-T10 

o X-T20 

o X-T30 

o X-T30 II 

o X-T30 III 

o X-T50 

o X-T100 

o X-T200 

o IS-1 

• GITUP  

o GIT2 

o GIT2P 

o G3 DUO (16:9 mode only) 

• Gione E7 

• GoPro  

o Fusion 

o HERO5 

o HERO6 

o HERO7 

o HERO8 

o HERO9 

o HERO10 

o HERO11 

o HERO12 

• Google  

o Pixel 

o Pixel XL 

o Pixel 3a 

o Pixel 4 XL 

o Pixel 4a (5G) 

o Pixel 5 

o Pixel 7a 

o Pixel 8 Pro 

o Pixel 9 Pro 

o Pixel 9 Pro XL 

o Pixel 9 Pro Fold 

o Pixel 10 
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o Pixel 10 Pro XL 

• HTC  

o UltraPixel 

o MyTouch 4G 

o One (A9) 

o One (M9) 

o 10 

o U12 

• Hasselblad  

o H2D-22 

o H2D-39 

o H3DII-22 

o H3DII-31 

o H3DII-39 

o H3DII-50 

o H3D-22 

o H3D-31 

o H3D-39 

o H4D-60 

o H4D-50 

o H4D-40 

o H4D-31 

o H5D-60 

o H5D-50 

o H5D-50c 

o H5D-40 

o H6D-100c 

o A6D-100c 

o CFV 

o CFV-50 

o CFV-50c 

o CFV II 50C 

o CFV-100c 

o CFH 

o CF-22 

o CF-31 

o CF-39 

o V96C 

o L1D-20c (DJI Mavic 2 Pro) 

o Lusso 

o Lunar 

o True Zoom 

o Stellar 

o Stellar II 

o HV 

o X1D 

o X1D II 50C 

o X2D 100C 

o X2D II 100C 



RawDigger User Guide 

Page 70 of 90 © Copyright 2012-2026, LibRaw LLC, www.libraw.com 

• Huawei  

o P8 Lite (PRA-LX1) 

o P9 (EVA-L09/AL00) 

o P10 (VTR-L09) 

o P10+ (VKY-L09) 

o P10 Lite (WAS-LX1A) 

o P20 (EML-L09) 

o P20 Lite (ANE-LX1) 

o P20 Pro (CLT-L29/L09) 

o P30 Pro (VOG-L29) 

o Honor6a 

o Honor7a pro 

o Honor8 (FRD-L09) 

o Honor9 

o Honor10 

o Honor20 

o Honor View 10 (BKL-L09) 

o Honor View 20 (PCT-L29) 

o Honor 20 Pro (YAL-L41) 

o Mate8 (NXT-L29) 

o Mate10 (BLA-L29) 

o Mate20 Pro (LYA-L29) 

o Mate20 Lite (SNE-LX1) 

• ISG 2020x1520 

• Ikonoskop  

o A-Cam dII Panchromatic 

o A-Cam dII 

• Imacon  

o Ixpress 96, 96C 

o Ixpress 384, 384C (single shot only) 

o Ixpress 132C 

o Ixpress 528C (single shot only) 

• JaiPulnix  

o BB-500CL 

o BB-500GE 

• Kandao QooCam 8K 

• Kinefinity  

o KineMINI 

o KineRAW Mini 

o KineRAW S35 

• Kodak  

o DC20 

o DC25 

o DC40 

o DC50 

o DC120 

o DCS200 

o DCS315C 

o DCS330C 
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o DCS420 

o DCS460 

o DCS460M 

o DCS520C 

o DCS560C 

o DCS620C 

o DCS620X 

o DCS660C 

o DCS660M 

o DCS720X 

o DCS760C 

o DCS760M 

o EOSDCS1 

o EOSDCS3 

o NC2000 

o ProBack 

o PB645C 

o PB645H 

o PB645M 

o DCS Pro 14n 

o DCS Pro 14nx 

o DCS Pro SLR/c 

o DCS Pro SLR/n 

o C330 

o C603 

o P850 

o P880 

o PIXPRO AZ901 

o PIXPRO S-1 

o Z980 

o Z981 

o Z990 

o Z1015 

o KAI-0340 

• Konica  

o KD-400Z 

o KD-510Z 

• LG  

o G3 

o G4 

o G5 (H850) 

o G6 

o V20 (F800K) 

o V20 (H910) 

o VS995 

• Leaf  

o AFi 5 

o AFi 6 

o AFi 7 
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o AFi-II 6 

o AFi-II 7 

o AFi-II 10 

o AFi-II 10R 

o Aptus-II 5 

o Aptus-II 6 

o Aptus-II 7 

o Aptus-II 8 

o Aptus-II 10 

o Aptus-II 12 

o Aptus-II 12R 

o Aptus 17 

o Aptus 22 

o Aptus 54S 

o Aptus 65 

o Aptus 65S 

o Aptus 75 

o Aptus 75S 

o Cantare 

o Cantare XY 

o CatchLight 

o CMost 

o Credo 40 

o Credo 50 

o Credo 60 

o Credo 80 

o DCB-II 

o Valeo 6 

o Valeo 11 

o Valeo 17 

o Valeo 17wi 

o Valeo 22 

o Valeo 22wi 

o Volare 

• Leica  

o C (Typ 112) 

o CL 

o C-Lux / CAM-DC25 

o Digilux 2 

o Digilux 3 

o Digital-Modul-R 

o D-LUX2 

o D-LUX3 

o D-LUX4 

o D-LUX5 

o D-LUX6 

o D-LUX7 

o D-Lux8 

o D-Lux (Typ 109) 
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o M8 

o M8.2 

o M9 

o M10 

o M10-D 

o M10-P 

o M10-R 

o M10 Monochrom 

o M11 

o M11 Monochrom 

o M (Typ 240) 

o M (Typ 262) 

o Monochrom (Typ 240) 

o Monochrom (Typ 246) 

o M-D (Typ 262) 

o M-E 

o M-P 

o M EV1 

o R8 

o Q (Typ 116) 

o Q-P 

o Q2 

o Q2 Monochrom 

o Q3 

o Q3 43 

o Q3 Monochrom 

o S 

o S2 

o S3 

o S (Typ 007) 

o SL (Typ 601) 

o SL2 

o SL2-S 

o SL3 

o T (Typ 701) 

o TL 

o TL2 

o X1 

o X (Typ 113) 

o X2 

o X-E (Typ 102) 

o X-U (Typ 113) 

o V-LUX1 

o V-LUX2 

o V-LUX3 

o V-LUX4 

o V-LUX5 

o V-Lux (Typ 114) 

o X VARIO (Typ 107) 
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• Lenovo a820 

• Logitech Fotoman Pixtura 

• Mamiya ZD 

• Matrix 4608x3288 

• Meizy MX4 

• Micron 2010 

• Minolta  

o RD175 / Agfa ActionCam 

o DiMAGE 5 

o DiMAGE 7 

o DiMAGE 7i 

o DiMAGE 7Hi 

o DiMAGE A1 

o DiMAGE A2 

o DiMAGE A200 

o DiMAGE G400 

o DiMAGE G500 

o DiMAGE G530 

o DiMAGE G600 

o DiMAGE Z2 

o Alpha/Dynax/Maxxum 5D 

o Alpha/Dynax/Maxxum 7D 

• Motorola  

o PIXL 

o Moto G (5S) 

o Moto G7 Play 

• Nikon  

o D1 

o D1H 

o D1X 

o D2H 

o D2Hs 

o D2X 

o D2Xs 

o D3 

o D3s 

o D3X 

o D4 

o D4s 

o D40 

o D40X 

o D5 

o D50 

o D6 

o D60 

o D70 

o D70s 

o D80 

o D90 
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o D100 

o D200 

o D300 

o D300s 

o D500 

o D600 

o D610 

o D700 

o D750 

o D780 

o D800 

o D800E 

o D810 

o D810A 

o D850 

o D3000 

o D3100 

o D3200 

o D3300 

o D3400 

o D3500 

o D5000 

o D5100 

o D5200 

o D5300 

o D5500 

o D5600 

o D7000 

o D7100 

o D7200 

o D7500 

o Df 

o Z 5 

o Z 5 II 

o Z 6 

o Z 6 II 

o Z 6 III 

o Z 7 

o Z 7 II 

o Z 8 

o Z 9 

o Z 30 

o Z 50 

o Z 50 II 

o Z f 

o Z fc 

o ZR 

o 1 AW1 

o 1 J1 
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o 1 J2 

o 1 J3 

o 1 J4 

o 1 J5 

o 1 S1 

o 1 S2 

o 1 V1 

o 1 V2 

o 1 V3 

o Coolpix 700 ("DIAG RAW" hack) 

o Coolpix 800 ("DIAG RAW" hack) 

o Coolpix 880 ("DIAG RAW" hack) 

o Coolpix 900 ("DIAG RAW" hack) 

o Coolpix 950 ("DIAG RAW" hack) 

o Coolpix 990 ("DIAG RAW" hack) 

o Coolpix 995 ("DIAG RAW" hack) 

o Coolpix 2100 ("DIAG RAW" hack) 

o Coolpix 2500 ("DIAG RAW" hack) 

o Coolpix 3200 ("DIAG RAW" hack) 

o Coolpix 3700 ("DIAG RAW" hack) 

o Coolpix 4300 ("DIAG RAW" hack) 

o Coolpix 4500 ("DIAG RAW" hack) 

o Coolpix 5000 

o Coolpix 5400 

o Coolpix 5700 

o Coolpix 8400 

o Coolpix 8700 

o Coolpix 8800 

o Coolpix A 

o Coolpix A1000 

o Coolpix B700 

o Coolpix P330 

o Coolpix P340 

o Coolpix P950 

o Coolpix P6000 

o Coolpix P1000 

o Coolpix P1100 

o Coolpix P7000 

o Coolpix P7100 

o Coolpix P7700 

o Coolpix P7800 

o Coolpix S6 ("DIAG RAW" hack) 

o Coolscan NEF 

• Nokia  

o 7 Plus 

o 8.3 5G 

o 9 

o N95 

o X2 
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o 1200x1600 

o Lumia 930 

o Lumia 950 XL 

o Lumia 1020 

o Lumia 1520 

• OM  

o Digital Solutions OM-1 

o Digital Solutions OM-1 Mark II 

o Digital Solutions OM-3 

o Digital Solutions OM-5 

o Digital Solutions OM-5 Mark II 

• Olympus  

o AIR A01 

o C-3030Z 

o C-5050Z 

o C-5060WZ 

o C-7070WZ 

o C-70Z / C-7000Z 

o C-740UZ 

o C-770UZ 

o C-8080WZ 

o X200 / D-560Z / C-350Z 

o E-1 

o E-3 

o E-5 

o E-10 

o E-20 / E-20N / E-20P 

o E-30 

o E-300 

o E-330 

o E-400 

o E-410 

o E-420 

o E-450 

o E-500 

o E-510 

o E-520 

o E-600 

o E-620 

o E-P1 

o E-P2 

o E-P3 

o E-P5 

o E-P7 

o E-PL1 

o E-PL1s 

o E-PL2 

o E-PL3 

o E-PL5 
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o E-PL6 

o E-PL7 

o E-PL8 

o E-PL9 

o E-PL10 

o E-PM1 

o E-PM2 

o E-M1 

o E-M1 Mark II 

o E-M1 Mark III 

o E-M1X 

o E-M10 

o E-M10 Mark II 

o E-M10 Mark III 

o E-M10 Mark IV 

o E-M5 

o E-M5 Mark II 

o E-M5 Mark III 

o Pen-F 

o SP-310 

o SP-320 

o SP-350 

o SP-500UZ 

o SP-510UZ 

o SP-550UZ 

o SP-560UZ 

o SP-565UZ 

o SP-570UZ 

o Stylus 1 

o Stylus 1s 

o SH-2 

o SH-3 

o TG-4 

o TG-5 

o TG-6 

o TG-7 

o XZ-1 

o XZ-2 

o XZ-10 

• OmniVision  

o 4688 

o OV5647 

o OV5648 

o OV8850 

o 13860 

• OnePlus  

o 6 (A6003) 

o 6T 

o 7 Pro (GM1913) 
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o 8 Pro (IN2023) 

o One 

o A3303 

o A5000 

• PARROT  

o Anafi 

o Bebop 2 

o Bebop Drone 

• Panasonic  

o DMC-CM1 

o DMC-FZ8 

o DMC-FZ18 

o DMC-FZ28 

o DMC-FZ30 

o DMC-FZ35 / FZ38 

o DMC-FZ40 / FZ42 / FZ45 

o DMC-FZ50 

o DMC-FZ70 / FZ72 

o DC-FZ80 / FZ81 / FZ82 / FZ83 / FZ85 

o DMC-FZ100 

o DMC-FZ150 

o DMC-FZ200 

o DMC-FZ300 / FZ330 

o DMC-FZ1000 

o DC-FZ1000 II / FZ1000M2 / DC-FZ10002 

o DMC-FZ2000 / FZ2500 / FZH1 

o DMC-FX150 / FX180 

o DMC-G1 

o DMC-G10 

o DMC-G2 

o DMC-G3 

o DMC-G5 

o DMC-G6 

o DMC-G7 / G70 

o DMC-G8 / G80 / G81 / G85 

o DC-G9 

o DC-G9 Mark II 

o DC-G90 / G95 / G91 / G99/ G97/ G95D/ G99D/ G99M2 

o DC-G100 / G110/ G110D 

o DMC-GF1 

o DMC-GF2 

o DMC-GF3 

o DMC-GF5 

o DMC-GF6 

o DMC-GF7 

o DC-GF10 / GF90 

o DMC-GH1 

o DMC-GH2 

o DMC-GH3 
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o DMC-GH4 

o AG-GH4 

o DC-GH5 

o DC-GH5S 

o DC-GH5 Mark II 

o DC-GH6 

o DC-GH7 

o DMC-GM1 

o DMC-GM1s 

o DMC-GM5 

o DMC-GX1 

o DMC-GX7 

o DMC-GX8 

o DC-GX9 / GX7mkIII 

o DMC-GX80 / GX85, DMC-GX7mkII 

o DC-GX800 / GX850, DC-GF9 

o DMC-L1 

o DMC-L10 

o DMC-LC1 

o DMC-LF1 

o DMC-LX1 

o DMC-LX2 

o DMC-LX3 

o DMC-LX5 

o DMC-LX7 

o DMC-LX9 / LX10 / LX15 

o DMC-LX100 

o DC-LX100M2 

o DC-S1 

o DC-S1 II (DC-S1M2) 

o DC-S1 IIE (DC-S1M2ES) 

o DC-S1H 

o DC-S1R 

o DC-S1R MkII 

o DC-S5 

o DC-S5 MkII/S5 MkII(X) 

o DC-S9 

o DMC-ZS40, DMC-TZ60 / TZ61 

o DMC-ZS50, DMC-TZ70 / TZ71 

o DMC-ZS60, DMC-TZ80 / TZ81 / TZ82 / TZ85 

o DC-ZS70, DC-TZ90 / TZ91 / TZ92 / TZ93 

o DC-ZS80, DC-TZ95 / TZ96 / TZ97/ ZS80D/ TZ95D/ TX96D/ ZS99/ TZ99 

o DMC-ZS100 / ZS110, DMC-TZ100 / TZ101 / TZ110, DMC-TX1 

o DC-ZS200 / ZS220, DC-TZ200 / TZ202 / TZ220, DC-TX2 

o DC-ZS200D / ZS220D, DC-TZ200D / TZ202D / TZ220D 

• Pentax  

o *ist D 

o *ist DL 

o *ist DL2 
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o *ist DS 

o *ist DS2 

o K10D 

o K20D 

o K100D 

o K100D Super 

o K110D 

o K200D 

o K2000/K-m 

o KF 

o KP 

o K-x 

o K-r 

o K-01 

o K-1 

o K-1 Mark II 

o K-3 

o K-3 Mark II 

o K-3 Mark III 

o K-3 Mark III Monochrome 

o K-30 

o K-5 

o K-5 II 

o K-5 IIs 

o K-50 

o K-500 

o K-7 

o K-70 

o K-S1 

o K-S2 

o MX-1 

o Q 

o Q7 

o Q10 

o QS-1 

o Optio S (secret menu or hack) 

o Optio S4 (secret menu or hack) 

o Optio 33WR (secret menu or hack) 

o Optio 750Z (secret menu or hack) 

o 645D 

o 645Z 

• PhaseOne  

o IQ140 

o IQ150 

o IQ160 

o IQ180 

o IQ180 IR 

o IQ250 

o IQ260 
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o IQ260 Achromatic 

o IQ280 

o IQ3 50MP 

o IQ3 60MP 

o IQ3 80MP 

o IQ3 100MP 

o IQ3 100MP Trichromatic 

o IQ4 150MP 

o LightPhase 

o Achromatic+ 

o H 10 

o H 20 

o H 25 

o P 20 

o P 20+ 

o P 21 

o P 25 

o P 25+ 

o P 30 

o P 30+ 

o P 40+ 

o P 45 

o P 45+ 

o P 65 

o P 65+ 

• Photron BC2-HD 

• Pixelink A782 

• Polaroid x530 

• PtGrey GRAS-50S5C 

• RaspberryPi  

o Camera 

o Camera V2 

o HQ Camera 

• Realme 3 Pro 

• Ricoh  

o GR 

o GR II 

o GR III 

o GR IIIx 

o GR IV 

o GR Digital 

o GR Digital II 

o GR Digital III 

o GR Digital IV 

o Caplio GX100 

o Caplio GX200 

o GXR Mount A12 

o GXR GR Lens A12 50mm F2.5 Macro 

o GXR GR Lens A12 28mm F2.5 
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o GXR Ricoh Lens A16 24-85mm F3.5-5.5 

o GXR Ricoh Lens S10 24-72mm F2.5-4.4 VC 

o GXR Ricoh Lens P10 28-300 mm F3.5-5.6 VC 

• Rollei d530flex 

• RoverShot 3320af 

• SMaL  

o Ultra-Pocket 3 

o Ultra-Pocket 4 

o Ultra-Pocket 5 

• STV680 VGA 

• SVS SVS625CL 

• Samsung  

o EX1 / TL500 

o EX2F 

o GX-1L 

o GX-1S 

o GX10 

o GX20 

o Galaxy Nexus 

o Galaxy Note 9 

o Galaxy NX (EK-GN120) 

o Galaxy S3 

o Galaxy S6 (SM-G920F) 

o Galaxy S7 

o Galaxy S7 Edge 

o Galaxy S8 (SM-G950U) 

o Galaxy S9 (SM-G960F) 

o Galaxy S9+ (SM-G965U / 965F) 

o Galaxy S10 (SM-G973F) 

o Galaxy S10+ (SM-G975U) 

o Galaxy S22 Ultra (SM-S908B) 

o Galaxy S23+ 

o Galaxy S23 Ultra 

o NX1 

o NX5 

o NX10 

o NX11 

o NX100 

o NX1000 

o NX1100 

o NX20 

o NX200 

o NX210 

o NX2000 

o NX30 

o NX300 

o NX300M 

o NX3000 

o NX500 
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o NX mini / NXF1 

o Pro815 

o WB550 / WB560 / HZ15W 

o WB2000 / TL350 

o WB5000 / HZ25W 

o S85 (hacked) 

o S850 (hacked) 

• Sarnoff 4096x5440 

• Seitz  

o 6x17 

o Roundshot D3 

o Roundshot D2X 

o Roundshot D2Xs 

• Sigma  

o BF 

o fp 

o fp L 

o SD9 (raw decode only) 

o SD10 (raw decode only) 

o SD14 (raw decode only) 

o SD15 (raw decode only) 

o SD1 

o SD1 Merrill 

o DP1 

o DP1 Merrill 

o DP1S 

o DP1X 

o DP2 

o DP2 Merrill 

o DP2S 

o DP2X 

o DP3 Merrill 

o dp0 Quattro 

o dp1 Quattro 

o dp2 Quattro 

o dp3 Quattro 

o sd Quattro 

o sd Quattro H 

• Sinar  

o eMotion 22 

o eMotion 54 

o eSpirit 65 

o eMotion 75 

o eVolution 75 

o 3072x2048 (Sinarback 23) 

o 4080x4080 (Sinarback 44) 

o 4080x5440 

o STI format 

o Sinarback 54 
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• Skydio 2+ 

• Sony  

o ILCE-1 (A1) 

o ILCE-1M2 (A1 II) 

o ILCE-7 (A7) 

o ILCE-7M2 (A7 II) 

o ILCE-7M3 (A7 III) 

o ILCE-7M4 (A7 IV) 

o ILCE-7M5 (A7 V) (Lossless compression only) 

o ILCE-7C (A7C) 

o ILCE-7CR (A7CR) 

o ILCE-7CM2 (A7C II) 

o ILCE-7R (A7R) 

o ILCE-7RM2 (A7R II) 

o ILCE-7RM3 (A7R III) 

o ILCE-7RM3A (A7R IIIA) 

o ILCE-7RM4 (A7R IV) 

o ILCE-7RM4A (A7R IVA) 

o ILCE-7RM5 (A7R V) 

o ILCE-7S (A7S) 

o ILCE-7SM2 (A7S II) 

o ILCE-7SM3 (A7S III) 

o ILCE-9 (A9) 

o ILCE-9M2 (A9 II) 

o ILCE-9M3 (A9 III) 

o ILCA-68 (A68) 

o ILCA-77M2 (A77-II) 

o ILCA-99M2 (A99-II) 

o ILCE-3000 / 3500 

o ILCE-5000 

o ILCE-5100 

o ILCE-6000 

o ILCE-6100 

o ILCE-6100A 

o ILCE-6300 

o ILCE-6400 

o ILCE-6400A 

o ILCE-6500 

o ILCE-6600 

o ILCE-6700 

o ILCE-QX1 / UMC-R10C 

o ILME-FX2 

o ILX-LR1 

o DSC-F828 

o DSC-HX95 

o DSC-HX99 

o DSC-R1 

o DSC-RX0 

o DSC-RX0 II 
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o DSC-RX1 

o DSC-RX1R 

o DSC-RX1R II 

o DSC-RX1R III 

o DSC-RX10 

o DSC-RX10 II 

o DSC-RX10 III 

o DSC-RX10 IV 

o DSC-RX100 

o DSC-RX100 II 

o DSC-RX100 III 

o DSC-RX100 IV 

o DSC-RX100 V 

o DSC-RX100 VA 

o DSC-RX100 VI 

o DSC-RX100 VII 

o DSC-RX100 VIIA 

o DSC-V3 

o DSLR-A100 

o DSLR-A200 

o DSLR-A230 

o DSLR-A290 

o DSLR-A300 

o DSLR-A330 

o DSLR-A350 

o DSLR-A380 / A390 

o DSLR-A450 

o DSLR-A500 

o DSLR-A550 

o DSLR-A560 

o DSLR-A580 

o DSLR-A700 

o DSLR-A850 

o DSLR-A900 

o NEX-3 

o NEX-3N 

o NEX-5 

o NEX-5N 

o NEX-5R 

o NEX-5T 

o NEX-6 

o NEX-7 

o NEX-C3 

o NEX-F3 

o NEX-VG20 

o NEX-VG30 

o NEX-VG900 

o SLT-A33 

o SLT-A35 



RawDigger User Guide 

Page 87 of 90 © Copyright 2012-2026, LibRaw LLC, www.libraw.com 

o SLT-A37 

o SLT-A55(V) 

o SLT-A57 

o SLT-A58 

o SLT-A65(V) 

o SLT-A77(V) 

o SLT-A99(V) 

o XCD-SX910CR 

o IMX135-mipi 13mp 

o IMX135-QCOM 

o IMX072-mipi 

o IMX214 

o IMX219 

o IMX230 

o IMX298-mipi 16mp 

o IMX219-mipi 8mp 

o Xperia 5 II (XQ-AS52) 

o Xperia L 

o Xperia 1 III 

o Xperia 1 IV (XQ-CT54) 

o ZV-1 (DCZV1/B) 

o ZV-1M2 

o ZV-E1 

o ZV-E10 

o ZV-E10 II 

• Vivo X51 5G (V2006) 

• Xiaomi  

o 12S Ultra (2203121C) 

o 13 Pro (2210132G) 

o 15 Ultra (25010PN30G) 

o MI3 

o MI 8 

o MI 9 Lite 

o MI MAX 

o POCO M3 

o RedMi Note3 Pro 

o RedMi Note7 

o RedMi Note 8T 

o FIMI X8SE 

• Xiaoyi YIAC3 (YI 4k) 

• YUNEEC  

o CGO3 

o CGO3P 

o CGO4 

• Yi M1 

• Zeiss ZX1 

• Zenit M 
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Copyrights and Acknowledgments 
RawDigger uses Qt 5.12 (v4.8.6 for legacy version), LibRaw library, RawSpeed library, LibXML2 and LibJPEG-

turbo libraries, and Microsoft Visual Studio runtime library. 

The program includes ExifTool utility. 

All trademarks mentioned in this manual are the property of their owners. 

ExifTool 

Copyright 2003-2019, Phil Harvey 

This is free software; you can redistribute it and/or modify it under the same terms as Perl itself. 

ExifTool is used in accordance with Perl Artistic License, please see exiftool-artistic-license.html file in the 

program directory. 

LibRaw  

LibRaw: raw images processing library 

Copyright (C) 2008-2019 LibRaw LLC (http://www.libraw.org, info@libraw.org) 

Qt 5.12 

Copyright (C) 2016 The Qt Company Ltd. 

Contact: https://www.qt.io/licensing/ 

Qt library is used under the terms of GNU LESSER GENERAL PUBLIC LICENSE 2.1, see file LICENSE.LGPL in the 

RawDigger program directory. 

Qt 4.8 

Copyright (C) 2014 Digia Plc and/or its subsidiary(-ies). 

Contact: http://www.qt-project.org/legal 

Qt library is used under the terms of GNU LESSER GENERAL PUBLIC LICENSE 2.1, see file LICENSE.LGPL in the 

RawDigger program directory. 

Qt uses a number of freeware libraries; their list and copyrights are contained in file QT-Third-Party-

Licenses.rtf LGPL in the RawDigger program directory. 

RawSpeed library 

RawSpeed - RAW file decoder. 

Copyright (C) 2009 Klaus Post 

This library is free software; you can redistribute it and/or modify it under the terms of the GNU Lesser 

General Public License as published by the Free Software Foundation; either  version 2 of the License, or (at 

your option) any later version. 

https://www.qt.io/licensing/
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This library is distributed in the hope that it will be useful, but WITHOUT ANY WARRANTY; without even the 

implied warranty of MERCHANTABILITY or FITNESS FOR A PARTICULAR PURPOSE.  See the GNU Lesser 

General Public License for more details. 

LibJPEG-turbo 

Copyright 2009 Pierre Ossman <ossman@cendio.se> for Cendio AB 

Copyright 2010 D. R. Commander 

Based on x86 SIMD extension for IJG JPEG library - version 1.02 

Copyright (C) 1999-2006, MIYASAKA Masaru. 

This software is provided 'as-is', without any express or implied warranty.  In no event will the authors be 

held liable for any damages arising from the use of this software. Permission is granted to anyone to use this 

software for any purpose, including commercial applications, and to alter it and redistribute it freely, 

subject to the following restrictions: 

1. The origin of this software must not be misrepresented; you must not claim that you wrote the original 

software. If you use this software in a product, an acknowledgment in the product documentation would be    

appreciated but is not required. 

2. Altered source versions must be plainly marked as such, and must not be misrepresented as being the 

original software. 

3. This notice may not be removed or altered from any source distribution. 

LibTIFF 

Copyright (c) 1988-1997 Sam Leffler 

Copyright (c) 1991-1997 Silicon Graphics, Inc. 

Permission to use, copy, modify, distribute, and sell this software and its documentation for any purpose is 

hereby granted without fee, provided that (i) the above copyright notices and this permission notice appear 

in all copies of the software and related documentation, and (ii) the names of Sam Leffler and Silicon 

Graphics may not be used in any advertising or publicity relating to the software without the specific, prior 

written permission of Sam Leffler and Silicon Graphics. 

THE SOFTWARE IS PROVIDED "AS-IS" AND WITHOUT WARRANTY OF ANY KIND, EXPRESS, IMPLIED OR 

OTHERWISE, INCLUDING WITHOUT LIMITATION, ANY WARRANTY OF MERCHANTABILITY OR FITNESS FOR A 

PARTICULAR PURPOSE.   

IN NO EVENT SHALL SAM LEFFLER OR SILICON GRAPHICS BE LIABLE FOR ANY SPECIAL, INCIDENTAL, 

INDIRECT OR CONSEQUENTIAL DAMAGES OF ANY KIND, OR ANY DAMAGES WHATSOEVER RESULTING FROM 

LOSS OF USE, DATA OR PROFITS, WHETHER OR NOT ADVISED OF THE POSSIBILITY OF DAMAGE, AND ON 

ANY THEORY OF LIABILITY, ARISING OUT OF OR IN CONNECTION WITH THE USE OR PERFORMANCE OF THIS 

SOFTWARE. 
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LibJPEG 

The Independent JPEG Group's JPEG software 

This distribution contains a release of the Independent JPEG Group's free JPEG software.  You are welcome 

to redistribute this software and to use it for any purpose, subject to the conditions under LEGAL ISSUES, 

below. 

This software is the work of Tom Lane, Guido Vollbeding, Philip Gladstone, Bill Allombert, Jim Boucher, Lee 

Crocker, Bob Friesenhahn, Ben Jackson, Julian Minguillon, Luis Ortiz, George Phillips, Davide Rossi, Ge' 

Weijers, and other members of the Independent JPEG Group. 

IJG is not affiliated with the official ISO JPEG standards committee. 

LibXML2 

Copyright (C) 1998-2003 Daniel Veillard.  All Rights Reserved. 

Permission is hereby granted, free of charge, to any person obtaining a copy of this software and associated 

documentation files (the "Software"), to deal in the Software without restriction, including without 

limitation the rights to use, copy, modify, merge, publish, distribute, sublicense, and/or sell copies of the 

Software, and to permit persons to whom the Software is furnished to do so, subject to the following 

conditions: 

The above copyright notice and this permission notice shall be included in all copies or substantial portions 

of the Software. 

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR 

IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A 

PARTICULAR PURPOSE AND NONINFRINGEMENT.  IN NO EVENT SHALL THEDANIEL VEILLARD BE LIABLE FOR 

ANY CLAIM, DAMAGES OR OTHER LIABILITY, WHETHERIN AN ACTION OF CONTRACT, TORT OR OTHERWISE, 

ARISING FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE 

SOFTWARE. 

Except as contained in this notice, the name of Daniel Veillard shall not be used in advertising or otherwise 

to promote the sale, use or other dealings in this Software without prior written authorization from him. 

MICROSOFT VISUAL C++ 2010 RUNTIME LIBRARIES 

Copyright 2010 Microsoft Corp. 

Microsoft runtime libraries are distributed under the terms described in file MSVC-Runtime-EULA.rtf in the 

RawDigger program directory. 


	What is RawDigger
	RawDigger Editions feature table

	System Requirements
	Program Installation
	Windows
	Mac OS X

	Program Activation
	Manual Activation

	Program Usage
	Starting RawDigger
	Windows
	Mac OS X

	Main Program Window
	Working with the Main Window
	Display of the areas of under- and overexposure
	EXIF Window

	Program Menu
	File Menu
	View Menu
	Window Menu
	Selection Menu
	Help Menu
	Hot keys and Shortcuts
	MS Windows
	Mac OS X


	RawDigger Histograms
	Samples Table
	Saving Samples Table

	Selection Grid: processing color targets
	Saving/Loading grid settings

	Raster Image Data Export
	Processing of floating point data

	Preferences
	Display Options Tab
	Data Processing Tab
	Data Processing -> Vendor specific Tab
	Histograms Tab
	File Handling Tab
	Misc. Options Tab
	Over/Under Exposure tab
	Support of non-standard cameras

	Supported Cameras
	Copyrights and Acknowledgments
	ExifTool
	LibRaw
	Qt 5.12
	Qt 4.8
	RawSpeed library
	LibJPEG-turbo
	LibTIFF
	LibJPEG
	LibXML2
	MICROSOFT VISUAL C++ 2010 RUNTIME LIBRARIES


